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Part A Employability Skills (XII) 

S.No Units 
Duration 

(Hrs.) 

Marks 

1.  Unit 1: Communication Skills – IV 13 
 
 
 
 
 

10 

2.  Unit 2: Self-management Skills – IV 9 

3.  Unit 3: Basic ICT Skills- IV 6 

4.  Unit 4: Entrepreneurial Skills – IV 16 

5.  Unit 5: Green Skills – IV 6 

 Total 50 

 

 

 

  



Unit 1: Communication Skills - IV 

Learning Outcome 
2 MKS 

Theory (  Periods) 
Practical (       
Periods) 

Total Duration 
  

1. Describe the 
steps to active 
listening skills  
 

1. Importance of 
active listening at 
workplace 

2. Steps to active 
listening 

1. Demonstration of 
the key aspects of 
becoming active 
listener 

2. Preparing posters 
of steps for active 
listening 

6  

2. Demonstrate 
basic writing skills 
 

1. Writing skills to 
the following: 

 Sentence 
 Phrase 
 Kinds of 

Sentences 
 Parts of 

Sentence 
 Parts of Speech 
 Articles 
 Construction of 

a Paragraph 

1. Demonstration 
and practice of 
writing sentences 
and paragraphs 
on topics related 
to the subject 

7  

Total 13 

 

  



Unit 2: Self-management –IV 

Learning Outcome Theory (  Periods) Practical ( Periods) 
Total Duration 
(11 Periods) 

1. Describe the 
various factors 
influencing self- 
motivation 

1. Finding and listing 
motives (needs and 
desires); 

2. Finding sources of 
motivation and 
inspiration (music, 
books,activities);expansi
ve thoughts; living fully 
in the present 
moment;dreaming big 

1. Group discussion 
on identifying 
needs and desire 

2. Discussion on 
sources of 
motivation and 
inspiration 

4 

2. Describe the 
basic personality 
traits, types and 
disorders 

1. Describe the meaning 
of personality 

2. Describe how 
personality influence 
others 

3. Describe basic 
personality traits 

4. Describe common 
personality disorders- 
paranoid, antisocial, 
schizoid, borderline, 
narcissistic, avoidant, 
dependent and 
obsessive 

1. Demonstrate the 
knowledge of 
different 
personality types 

5 

Total 9 

 

 

  



Unit 3: Information & Communication Technology – IV 

Learning Outcome Theory (    Periods) 
Practical (     
Periods) 

Total Duration 
 

1. Perform 
tabulation using 
spreadsheet 
application 

1. Introduction to 
spreadsheet 
application 

2. Spreadsheet 
applications 

3. Creating a new 
worksheet 

4. Opening 
workbook and 
entering text 

5. Resizing fonts 
and styles 

6. Copying and 
moving 

7. Filter and sorting 
8. Formulas and 

functions 
9. Password 

protection. 
10. Printing a 

spreadsheet. 
11. Saving a 

spreadsheet in 
various formats. 

1. Demonstration 
and practice on 
the following: 

 Introduction to 
the spreadsheet 
application 

 Listing the 
spreadsheet 
applications 

 Creating a new 
worksheet 

 Opening the 
workbook and 
enter text 

 Resizing fonts 
and styles 

 Copying and 
move the cell 
data 

 Sorting and Filter 
the data 

 Applying 
elementary 
formulas and 
functions 

 Protecting the 
spreadsheet with 
password 

 Printing a 
spreadsheet 

 Saving the 
spreadsheet in 
various formats 

3 

  



2. Prepare 
presentation using 
presentation 
application 

1. Introduction to 
presentation 

2. Software 
packages for 
presentation 

3. Creating a new 
presentation 

4. Adding a slide 
5. Deleting a slide 
6. Entering and 

editing text 
7. Formatting text 
8. Inserting clipart 

and images 
9. Slide layout 
10. Saving a 

presentation 
11. Printing a 

presentation 
document. 

1. Demonstration and 
practice on the 
following: 
 Listing the 

software 
packages for 
presentation 

 Explaining the 
features of 
presentation 

 Creating a new 
presentation 

 Adding a slide to 
presentation. 

 Deleting a slide 
 Entering and 

edit text 
 Formatting text 
 Inserting clipart 

and images 
 Sliding layout 
 Saving a 

presentation 
 Printing a 

presentation 
document 

3 

Total 6 

 

  



Unit 4: Entrepreneurship Development – IV 

Learning Outcome Theory (     Periods) 
Practical                           

(      Periods) 
Total Duration 
(16 Periods) 

1. Identify the 
general and 
entrepreneurial 
behavioural 
competencies 

1. Barriers to 
becoming 
entrepreneur 

2. Behavioural and 
entrepreneurial 
competencies – 
adaptability/decisiv
e ness, initiative/ 
perseverance, 
interpersonal skills, 
organizational 
skills, stress 
management, 
valuing service 
and diversity 

1. Administering self- 
rating 
questionnaire and 
score responses 
on each of the 
competencies 

2. Collect small 
story/ anecdote of 
prominent 
successful 
entrepreneurs 

3. Identify 
entrepreneurial 
competencies 
reflected in each 
story and connect 
it to the definition 
of behavioural 
competencies 

4. Preparation of 
competencies 
profile of students 

8 

2. Demonstrate the 
knowledge of self- 
assessment of 
behavioural 
competencies 

1. Entrepreneurial 
competencies in 
particular : self - 
confidence, 
initiative, seeing 
and acting on 
opportunities, 
concern for 
quality, goal 
setting and risk 
taking, problem 
solving and 
creativity, 
systematic 
planning and 
efficiency, 
information 
seeking, 
persistence, 
influencing and 
negotiating, team 
building 

1. Games and 
exercises on 
changing 
entrepreneurial 
behavior and 
development of 
competencies for 
enhancing self- 
confidence, 
problem solving, 
goal setting, 
information 
seeking, team 
building and 
creativity 

8 

Total 16 



Unit 5: Green Skills – IV 

Learning Outcome Theory (       Periods) Practical (    Periods) 
Total Duration 
(06 Periods) 

1. Identify the role 
and importance of 
green jobs in 
different sectors 

1. Role of green jobs in 
toxin-free homes, 

2. Green organic 
gardening, public 
transport and energy 
conservation, 

3. Green jobs in water 
conservation 

4. Green jobs in solar 
and wind power, 
waste reduction, 
reuse and recycling 
of wastes, 

5. Green jobs in green 
tourism 

6. Green jobs in building 
and construction 

7. Green jobs in 
appropriate 
technology 

8. Role of green jobs in 
Improving energy and 
raw materials use 

9. Role of green jobs in 
limiting greenhouse 
gas emissions 

10. Role of green jobs 
minimizing waste and 
pollution 

11. Role of green jobs in 
protecting and 
restoring ecosystems 

12. Role of green jobs in 
support adaptation to 
the effects of climate 
change 

1. Listing of green jobs 
and preparation of 
posters on green job 
profiles 

2. Prepare posters on 
green jobs. 

6 

Total 6 

 

 



  
Communication - Describe the steps to active listening skills 

1 
 

Worksheet 1  

Warm Up 

A Listening Cues Game 

In pairs take on the following roles: 

Role Play:Learning about Active Listening  

Phase 1  

Student 1 Read a news article to your partner, Student 2 . 

Read with proper expression and at a normal speed. 

Student 2 Do not show your card to your partner! 

You are a very poor listener. Display  poor listening behavior .You are :  

  fidgeting 

  looking around 

  interrupting to ask questions 

  making inappropriate facial expressions. 

Phase 2  

 Student 2  

   Explain /read  the article that was just read to him, back to Student 1  

Student 1 

 You should display positive listening skills. You are :  

 making eye contact 

  sitting still 

  making appropriate facial cues  
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  taking notes 

  waiting until the end to ask questions. 

 

Phase 3 All groups review the article together.  

  identify things   Student  2 missed because he wasn't listening closely  

  demonstrate how important it is to use proper listening behaviors to 

understand the message being relayed. 

B Listening With Distractions Game  

Phase 1  

 In groups of about 6 or more  students play the following game: 

 One student will play the role of teacher. 

 Tell them you will read out a story (any story will do).  

 Give one set of people on your left side a task.  

 For example, ask them to count now many times you say the word "and."  

 Ask others to count the number of times you smile.  

 Give the other set of students on your right side no task at all, except to listen.  

Phase 2  

 Read the story.  

 When you have finished, ask each group member to write down answers to 

three questions about your story.  

 Find out which group answered better. 

 You will find that the people who were distracted by a task may not answer the 

questions as easily as those who were listening without tasks.  

Phase 3 

All groups :Discuss how difficult it was for people to pay attention when they were not 

focused on the message itself. 
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C WARM-UP: TELEPHONE 

Introduction :Stand in a circle. Explain that you will be playing the game of Telephone. Ask if any 

student is familiar with the game and would like to explain how to play. 

1Start by whispering the following sentence into a student’s ear: “I want to know what it feels like to 

listen and what it feels like to be heard.” 

2This first student will then whisper what they think they heard into the next student’s ear. Students will 

repeat this process until the last person is reached. The last student will then say the word or phrase they 

heard out loud for the whole class to hear. More likely than not, the last student will have heard 

something totally different from the original message. 

3a)Next sit in a circle and discuss the following: 

 What happened to the original message? 

 Was it easy or difficult to hear the message? Why do you think it might have been difficult? 

b) Do you think the following reasons are correct? 

 It was hard to hear because the person was whispering.” 

 “We weren’t making eye contact.” 

 “Students were talking or laughing.” 

 “It’s hard to understand an isolated word or phrase without any context; i.e., without context, 

words and phrases can sound like they come from out of the blue.” 
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Worksheet 2  

A Review the warm ups you did in Worksheet 1.Keeping the activities in mind as well as other factors discuss the 

following  with your partner: 

1 What is listening ? 

2 How is it different from hearing ? 

a) Examine the sentences below and fill in the blanks with the correct word. Discuss what your choice of word 

tells you about the differences between hearing and listening.  

b) In pairs, make a table listing  the differences between listening and hearing. 

c) Check the information given in  Figures 1a and 1b.Add the new information to your table 

(i)I can’t ….(hear/listen) you. Could you speak louder please? 

(ii) My grandmother likes to ….(hear/listen) to the radio. 

(iii) Did you ……(listen/hear) the thunder last night/ 

(iv) The vet is …….(hearing /listening)to the dog’s heartbeat. 

Figure 1a)                                                                             Figure 1 b) 

 



  
Communication - Describe the steps to active listening skills 

5 
 

3 Look at Figure 2. Using the information on how listening and hearing differ fill in the blanks with 

suitable words. 

                                                        Figure 2 
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CS 11 Worksheet 3  

1Examine Figure 3 . 

Let us now think about the different stages of listening. listening 

2Using the words given in the box below  complete the table. 

3 Check your answers given at the end. 

Figure 3 

 

 

 

 

 

 

Stage 1  

_________ 

stage 2  

__________ 

Stage 3  

__________ 

stage 4  

_______ 

Stage 5 

Responding  

 

understanding, responding 
evaluating ,remembering 
receiving  

 

r,understanding 
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4 a)Look at  Figure 4,column A and B. What are the 5 stages of Listening .Under Column A write the 

numeral 1-5  and in Column B write the name of each of the stages in the correct order . 

b) Next, look at column C. It has the description of the 5 stages in jumbled order. Read carefully and 

match the different stages of listening  listed in Column  B with its corresponding description given 

in column C. 

                                      Figure 4  

 A                                 B                                                                    C 

s.n  
stages of listening 

 

                          description of the stage 
 

 
a) 
stage 
? 

____________ 
 

 

 attempts to figure out the meaning of the message. 

 

 

b 
stage 
? 

___________ 
 receiver provides verbal or nonverbal feedback about 

the speaker or message. 

 

 

c 
stage 
? 

 

_________  listener judges the content of the message or the character 
of the speaker 

d 
stage 
? 
 

__________ 
 this stage is represented by the ear because it is the primary tool involved 

with this  stage  of the  listening process 

 

e 
stage 
? 

_________  receiver either  places information into long-term memory 
or forgets the information presented 

 

 

 

  

   
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Worksheet 4  What is Active Listening ? 

A Read the following points which describe active Listening: 

1Active listening involves attentively seeking to understand a speaker’s message, rather than passively 

hearing the words that a speaker says. 

2Active Listeners provide verbal and nonverbal feedback to show their sincere investment in what the 

speaker is sharing. 

3Active listening can help to build trust within a conversation, thereby allowing the speaker to 

communicate more easily, openly and honestly. 

 

B Role Play :In pairs ,take on the following roles: 

 

1)Teacher  

 You have been teaching  the student about how to conduct an interview.. 

 You have seen the video recording of the interview.  

 You are now giving feedback and tips to your student on how to become an active listener. 

 Enact your role by reading aloud the script below..  

 

2)Student Interviewer  

 You are passionate about becoming a television interviewer. 

 You have recently taken an interview of an Alumnus who has excelled in Sports . 

 The interview has been videotaped. 

 You have come to your teacher for feedback.  

 Enact  your role by reading aloud the script below. 

  

                             Script : Feedback on Active Listening 
Teacher: Hello! I have watched the video of the interview you took. It’s a good one! I saw you 
being an  active listener. I was happy to see you using the techniques of being a good 
interviewer ! 
I noticed you leaned  forward to show that you were  interested !  
And ,you were smiling while the interviewee talked. Good…these are  examples of excellent 
nonverbal listening skills. 
 
Student I wanted to ask one question? Is it okay to interrupt the person I am interviewing? 
 
Teacher: No,no! Never interrupt. No matter how anxious you are to hear what 
someone has to say, you never interrupt. 
 
Student : But I see this happening on Television all the time! Reporters interrupt and cut off 
people off all the time.   
 
Teacher: Yes, I’ve seen that too! But remember you’re not here to get someone to confess to 
wrong doing or moderate a political debate. You’ve asked a classmate to 
share a very personal story. Remember what I told you in class? A good interviewer knows that 
the people they interview are important and conduct their interviews with respect and 
sensitivity and curiosity. 
 So, even if the person doesn’t answer the question you ask… let them finish their thoughts and 
don’t interrupt them.  
Let me tell a very good strategy that active listeners use…that is…to wait three to five seconds, 
counting quietly to yourself, before you ask the next question.  
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If you do this you might get some very  interesting facts and details which you might have 
missed otherwise! So never forget the cardinal rule …show your respect for the interviewer by 
never interrupting! 
 
Student  Oh thank you so very much Sir! I won’t ever forget this advice! But Sir, how was my 
interview on the whole?. 
 
Teacher: Overall, you did a great job! 
 You used body language to show  that you cared about the interviewee  without your having to 
speak.  
You also had very good follow-up questions. 
And you can only have good follow-up questions if you are listening to what a 
person is saying.  
Remember: don’t rush them, don’t interrupt them. Let them finish their thoughts. But most 
important, while she’s talking listen, listen, and listen. 
 
Student Oh thank you  Sir! I will remember these wonderful tips! Thank you! 
 

Adapted from Transcript :Tips for Active Listening 

© STORYCORPS, INC | MORE AT STORYCORPS.ORG 

 

C Discuss the following : 

1)Which of the tips given by the teacher were nonverbal strategies? 

2)Which of the  tips were verbal strategies? 

3)What are examples of other tips for active listening?  

4)Do you know how important the  strategies of pause and short silence are in active listening ?    Use 

short silences and do not interrupt the interviewee while interviewing.  

b) Role Play:In pairs interview each other, using the following prompt:  

(i)  Formation of pairs:Ask one student to conduct the pairing by  counting off. For example, if there are 

20 students, count off one to 10 and pair students who have the same number. If there are an uneven 

number of students, ask your teacher to participate. 

(i)Tell me something about yourself that might surprise me. 

(ii) While interviewing remember to  practice using short silences. This means that whenever the narrator 

stops speaking, the interviewer should pause for six to eight seconds (counting quietly to themselves) 

before asking a follow-up question. During this period, the narrator is free to add any details to their story. 

The interviewer will then need to wait for another opportunity to ask a follow-up question. 

(iii) Form  Pair students up by counting off. For example, if there are 20 students, count off one to 10 and 

pair students who have the same number. If there are an uneven number of students, ask your teacher to 

participate. 
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Student 1 will tell their story for five minutes total, with Student 2 pausing before they ask any follow-up 

questions. 

After you have interviewed for  5 minutes, switch roles. 

Discuss : 

1As the interviewer, how did it feel to pause before asking questions? 

2Were the pauses helpful when you were telling your story? 

3Did this listening exercise  differ from the other peer interviews we have done in class? If so, how? 

4Do you think people often use this method of ‘short silences’ in real life? 

5What does it feel like when someone interrupts you? 

6What do you think might cause someone to interrupt another person? 
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Worksheet 5 Why should you become an Active  Listener? 

5 a)Think of 5 important reasons why you should   become an active listener? The visuals given below in 
Figure 5(b) are clues to the possible answers ..  

                                                          Worksheet 4    Figure 5a 

 

                                                      Figure 5b 

     

 

 

 

 

 

 

 

 

_____  ____ 

_______ 

_______ 

______ 

__________________ 

________ 

_______  

__________ 

________  
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Worksheet 5(contd.)  Why is Active Listening Important for Interviews and at the Workplace? 

 adapted from  ALISON DOYLE 

5 b)Like critical thinking and problem-solving, active listening is a soft skill that’s held in high 

regard by employers.  Active listening  is extremely  important for interviews and at the 

workplace your career.  

1 An active listener does the following ; 

 avoids  interrupting at all costs 

  summarizes and repeats back what he/she has heard 

 observes body language to get an extra level of understanding.  

2 Active listening is a helpful skill for any worker to develop for the following reasons: 

 helps you truly understand what people are saying in conversations and meetings (and 

not just what you want to hear, or think you hear).  

 can help build rapport with your interviewer.  

 can  redirect one’s focus from what is going on inside one’s head to the needs of the  

prospective employer or interviewer.  

  can  help reduce your nervousness during an interview.  

3 An active listener shows that he/she is  : 

 a)  interested in the organization’s challenges and successes;  

 b)  ready to help them problem-solve work issues, and 

  c)  a team player as opposed to being nothing more than a self-absorbed job candidate.  

Remember the following: 

 Don’t interrupt, or worse, try to answer the question before you know what the 

interviewer is asking. 

 Listen carefully to the interviewer’s questions, ask for clarification if necessary, and wait 

until the interviewer has finished talking to r 

https://www.thebalancecareers.com/alison-doyle-2058389
https://www.thebalancecareers.com/critical-thinking-definition-with-examples-2063745
https://www.thebalancecareers.com/problem-solving-skills-with-examples-2063764
https://www.thebalancecareers.com/what-are-soft-skills-2060852
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5 c)1 Read about the 8 active listening techniques listed in column A:Each technique has an example given in 

Column B, but they are in jumbled order. 

2 Match the techniques given in Column A with its corresponding example in Column B. Number 4 i.e. brief verbal 

affirmations has been done for you 

 Worksheet 5 :Figure 6  

s.n  A:Technique                      B:Examples of Active Listening Techniques 

1  Building trust & 

rapport 

’How long do you expect your hiring process to last?” “What is your average rate 

of staff turnover?’ 

2  Demonstrating 

concern 

Tell me more about your proposal to reorganize the department.” “Can you 

please provide some history for me regarding your relationship with your former 

business partner?”  

3   Paraphrasing to   

show 

understanding 

‘’I was also very conflicted about returning to work after the birth of my son.” “I 

had the responsibility of terminating four of my personnel, due to downsizing, 

over the last two years. Even if it’s necessary, it never gets easier.”  

4  Brief verbal      

affirmations 

Tell me what I can do to help.” “I was really impressed to read on your website 

how you donate five percent of each sale to charity.” 

5  Asking open-ended 

Q’s 

“So, you are saying that the uncertainty about who will be your new supervisor is 

creating stress for you.” “So, you think that we need to build up our social media 

marketing efforts.”  

6  Asking specific 

Q’s,seeking  

clarification 

I am eager to help you; I know you are going through some tough challenges.” “I 

know how hard a corporate restructuring can be – how is staff morale at this 

point?”  

7  Waiting to disclose 

your opinion 

“  I understand that you would like more frequent feedback about your 

performance.” “Thank you. I appreciate your time in speaking to me.”I see,. I  

understand..,Sure etc 

8  Disclosing similar 

experiences to 

show 

understanding 

 I can see that John's criticism was very upsetting to you. Which aspect of his 

critique was most disturbing?” “It’s clear that the current situation is intolerable 

for you. What changes would you like to see?” 
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Tips for becoming an Active Listener! 

 Don’t interrupt, or worse, try to answer the question before you know what the 

interviewer is asking. 

 Listen carefully to the interviewer’s questions, ask for clarification if necessary, and wait 

until the interviewer has finished talking to r 

 

Finally never underestimate the power of “soft skills” (also known as “people skills”) like active 
listening, problem-solving, flexibility, self-motivation, leadership, and teamwork. Your CV or 
resume may look great, but don’t forget to nourish your soft skills. 

Especially for young, first-time job candidates with limited work experience, these people skills 
often are the deciding factor in whether an employer will be willing to take the risk in hiring them 
over others who may have more experience (but possibly weaker interpersonal communications 
talents). Don’t forget to highlight your soft skills in your interview (and even in your resume). 

                                                             

5d Using all that you have learnt about Active Listening prepare posters on the following topics: 

(i)What is Active Listening? 

(ii)Why is Active Listening important? 

(iii)How to become an Active Listener? 

(iv)  How to be successful in your interview?  

(v) Think of effective slogans to get your message across! 

 

 

 

 

 

https://www.thebalancecareers.com/problem-solving-skills-with-examples-2063764
https://www.thebalancecareers.com/workplace-flexibility-definition-with-examples-2059699
https://www.thebalancecareers.com/leadership-skills-list-2063757
https://www.thebalancecareers.com/job-interview-question-give-some-examples-of-teamwork-2061285
https://www.thebalancecareers.com/what-are-soft-skills-2060852
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                                                                    ANSWERS  

                                                          Worksheet 2 Answers: Figure 2  
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                                            Worksheet 3 Answers: Figure 3 

 add one more box and label it 

responding  

                                               Worksheet 4 Answers: Figure 4 

A B C 

s.n 
a) 
stage 
1 

stages of listening 
receiving 

 

 this stage is represented by the ear because it is the primary tool 

involved with this  stage  of the  listening process 

 

b 
stage 
2 

understanding 
 attempts to figure out the meaning of the message. 

 

c 
stage 
3 

 

remembering  receiver either  places information into long-term 
memory or forgets the information presented 

d 
stage 
4 
 

evaluating 
 listener judges the content of the message or the 

character of the speaker. 

 

e 
stage 
5 

responding 
 receiver provides verbal or nonverbal feedback about 

the speaker or message. 

 

 

 

 

Stage 1 
receiving 

stage 2  

understanding 

Stage 3 
remembering 

stage 4  

evaluating 
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Worksheet 4 Answers: Figure 5 

 

 

 

 

 

 

 

 

 

                     

  Worksheet 5 Answers: Figure 6 

better stu 

more effective 
in your 

relationships 

others percieve 
you as more 
intelligent 

strong public 
speaker  

successful at 
work  
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s.n  A:Techniques                      B: Examples of Active Listening Techniques 

1 Building trust & rapport ’How long do you expect your hiring process to last?” “What is your average rate of staff 

turnover?’ 

2 Demonstrating concern Tell me more about your proposal to reorganize the department.” “Can you please 

provide some history for me regarding your relationship with your former business 

partner?”  

3 Paraphrasing to show 

understanding 

‘’I was also very conflicted about returning to work after the birth of my son.” “I had the 

responsibility of terminating four of my personnel, due to downsizing, over the last two 

years. Even if it’s necessary, it never gets easier.”  

4 Brief verbal affirmations Tell me what I can do to help.” “I was really impressed to read on your website how you 

donate five percent of each sale to charity.” 

5 Asking open-ended Q’s “So, you are saying that the uncertainty about who will be your new supervisor is creating 

stress for you.” “So, you think that we need to build up our social media marketing 

efforts.”  

6 Asking specific 

Q’s,seeking  clarification 

I am eager to help you; I know you are going through some tough challenges.” “I know 

how hard a corporate restructuring can be – how is staff morale at this point?”  

7 Waiting to disclose your 

opinion 

“  I understand that you would like more frequent feedback about your performance.” 

“Thank you. I appreciate your time in speaking to me.”I see,..I  understand..,Sure etc 

8 Disclosing similar 

experiences to show 

understanding 

 I can see that John's criticism was very upsetting to you. Which aspect of his critique 

was most disturbing?” “It’s clear that the current situation is intolerable for you. What 

changes would you like to see?” 

                            

 

 

 

                                               Worksheet 5 Answers: Figure 6                                              
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A:Techniques                       B:Examples of Active Listening Techniques 

1 Building trust & rapport “Tell me what I can do to help.” “I was really impressed to read on your website how you donate 

five percent of each sale to charity.” 

2 Demonstrating concern “I am eager to help you; I know you are going through some tough challenges.” “I know how hard a 

corporate restructuring can be – how is staff morale at this point?”  

3 Paraphrasing to show 

understanding 

“So, you are saying that the uncertainty about who will be your new supervisor is creating stress 

for you.” “So, you think that we need to build up our social media marketing efforts.”  

4 Brief verbal affirmations “  I understand that you would like more frequent feedback about your performance.” “Thank you. I 

appreciate your time in speaking to me.”I see,..I  understand..,Sure etc 

5 Asking open-ended Q’s I can see that John's criticism was very upsetting to you. Which aspect of his critique was most 

disturbing?” “It’s clear that the current situation is intolerable for you. What changes would you like 

to see?” 

6 Asking specific Q’s, 

seeking  clarification 

‘’How long do you expect your hiring process to last?” “What is your average rate of staff 

turnover?’’ 

7 Waiting to disclose your 

opinion 

Tell me more about your proposal to reorganize the department.” “Can you please provide some 

history for me regarding your relationship with your former business partner?”  

8 Disclosing similar 

experiences to show 

understanding 

‘’I was also very conflicted about returning to work after the birth of my son.” “I had the 

responsibility of terminating four of my personnel, due to downsizing, over the last two years. Even 

if it’s necessary, it never gets easier.”  

 

 



 

 

                                         Communication skills 

What is communication? 

Communication is the act of conveying meanings from one entity or 

group to another through the use of mutually understood signs, 

symbols, and semiotic rules. 

                                    

    *The following figure represents types of communication 

                                      (Fig 1) 

 

         Learning objectives of Effective communication 

1. Development of Interpersonal Skills 

2. To express effectively & with maximum efficiency 

What is Writing? 

Writing is a form of communication that allows students to put their 

feelings and ideas on paper, to organize their knowledge and beliefs into 

convincing arguments, and to convey meaning through well-constructed 

text. In its most advanced form, written expression can be as vivid as a work 

of art.                                   

                                      Grade 12 

    



 

 

1.Sentences-A sentence is a group of words giving a complete thought. A 

sentence must contain a subject and a verb. 

The main focus  here is to improve basic sentence composition skills. One can 

review the types of sentences and the functions of their component parts 

listed below. 

Simple, compound, and complex sentences 

a)  Simple sentence- 

 A simple sentence is one independent clause that has a subject and a verb 

and expresses a complete thought. Notice that there are some important 

requirements for a simple sentence: 

 Must have a subject and a verb. 

 Must express a complete thought. 

 Must only have one clause. 

Examples 

 I am out of paper for the printer. 

 Will you help me with the math homework? 

b) Compound Sentence 

A compound sentence allows us to share a lot of information by 

combining two or more related thoughts into one sentence. It combines 

two independent clauses by using a conjunction like “and.” This creates 

sentences that are more useful than writing many sentences with 

separate thoughts. 

           Example of Compound Sentences 

     We use compound sentences all of the time. Here are some examples, the      

independent clause is green, the second is purple, and the conjunctions are    

orange: 

 

1.I drove to the office, and then I walked to the cabin.  

c) Complex sentence –  

A complex sentence is a sentence that combines one independent clause with 

at least one dependent clause. 

 Example 



 

 

 Although  Rohan had some doubts, he found the courses very useful. 

The above example is a complex sentence: it has a dependent clause (a subject 

' Rohan' and a verb 'had'), followed by an independent clause (subject 'he' and 

a verb 'found') and forms a complete thought. 

 Computers have come a long way since they first came on the market. 

This example begins with an independent clause (subject 'computers' 

and verb 'have come') that forms a complete thought, followed by a 

dependent clause (subject 'they' and a verb 'came'). 

 https://study.com/academy/lesson/types-of-sentences-simple-compound-

complex.html#lesson  

The link mentioned above will further will help the students to strengthen their 

concept on the above mentioned topics   

 

Writing skills 

 Activity- Mini sagas 

Sometimes when we ask students to write a composition they spend very little 

time at the important editing stage. In this lesson students will do a couple of 

‘short writing’ activities with the focus on editing and accuracy. 

A mini saga is a piece of writing with exactly fifty words. It has to tell a story, 

have a beginning, a middle and an ending. Mini sagas were ‘invented’ by the 

Science fiction writer Brian Aldiss, who thought it would be fun and challenging 

to tell/write  a story in very few words. 

 

Students work alone to write a mini saga. First they should spend a few 

minutes thinking of what they are going to write about.  The teacher will 

discuss  few ideas on the board to help: A description of a favourite object, 

place, person; a joke,something funny or scary that happened with the 

student; a synopsis of a film they have watched or a book they have read; a 

letter to an old school teacher,friend or relative. Students write their first 

draft,then spend time editing, cutting out or adding words until the text has 

exactly 50 words 

https://study.com/academy/lesson/types-of-sentences-simple-compound-complex.html#lesson
https://study.com/academy/lesson/types-of-sentences-simple-compound-complex.html#lesson


 

 

 

   The above figure is an example of  a Mini saga 

 It will help the students to learn how to edit their writing and to help students 

understand that ‘quality’ is more important than ‘quantity’ when it comes to 

writing and make them understand that ‘quality’ is more important than 

‘quantity’ when it comes to writing 

 A worksheet can be taken up in the class to test the concept clarity. 

 

                                      

 
                                              Worksheet 
Identify the following sentences as simple,compound or complex. 
 
1. The production of a single pound of honey requires nectar from approximately 

two million flowers. 
2. The vibrant trumpet-shaped blooms of the trumpet vine make it ideal for 

attracting hummingbirds. 
3. We can watch the boxing match, which will be broadcast at nine o'clock, or we can 

view the documentary about the greatest innovations of the twenty-first century. 
4. Russia has a variety of natural resources, including oil, natural gas, timber, iron 

ore, copper and lead. 
5. The right hemisphere of the human brain typically controls muscle movement on 

the left side of the body. 
6. Aaron has an unconventional swing, but he manages to drive the ball farther than 

some professional golfers. 



 

 

7. During last night's thunderstorm, a flurry of tiny hailstones danced across the roof 
of our house. 

8. An avid reader, Thomas attends weekly book club meetings, and he finishes 
several novels every month. 
 
 

 
  
 
 
 
     

 

 

 

 2.Phrases - Phrases are a group of words that work together to communicate 

an element of speech. 

The following link further explains use of phrases in communicating better and 

with much ease. 

 Types of phrases 

1.Noun Phrase 

A noun phrase is any noun or pronoun along with its modifiers: 

Example –  

 The school children 

 Yesterday’s newspaper 

2. Verb Phrase 

A verb phrase is any number of verbs working together: 

              Example 

 Had been sleeping 

 Will contact 

 May have written 

3. Prepositional Phrase 



 

 

A prepositional phrase always starts with a preposition and ends with a noun 

or pronoun (and its modifiers) that is called the object of the preposition: 

        Example 

 Through the wheat field 

 Preposition: through 

 Object of the preposition: the wheat field 

   Some more examples of prepositional phrases: 

 During the year 

 Despite complaints 

4. Verbal Phrases 

There are three types of verbal phrases: participial phrases, gerund phrases, 

and infinitive phrases. Each is explained below. 

 

a) Participial Phrase 

Participial phrases start with either a present or past participle. Here are some 

examples of each. 

Phrase with present participles: 

 Watching silently 

Phrases with past participles: 

 Driven to succeed 

b) Gerund Phrase 

A gerund phrase is a present participle (and its modifiers) that acts like a 

noun. It can take on a variety of jobs in the sentence. Here are a couple 

of examples: 

 Practicing helped a lot. (subject) 

 I love reading. (direct object) 

c) Infinitive Phrase 

An infinitive phrase is the infinitive and its modifiers: 

Example 

 To sing 



 

 

 To walk all that way 

d) Appositive Phrase 

An appositive phrase is a phrase that renames an earlier noun or pronoun 

My best friend, Nick Palacio, loves scuba diving. 

We watched Sirius, the brightest star in the sky 

e) Absolute Phrase 

Absolute phrases are the trickiest to identify. These phrases are not closely 

connected to the rest of the sentence; they don’t describe a specific word, 

but modify the whole sentence. They add extra information and are usually 

separated by commas (or dashes).  

Example 

The semester finished, Karen sold all her textbooks. 

                 Absolute phrase: The semester finished 

          A worksheet can be taken up in the class to further built up the 

concept 

 
 
    For each sentence, Identify the phrase  and state its kind. 
 
 
 1. He was a man of great wealth. 
 
2. The principal was an old man of friendly disposition. 
 
3. The workers belonged to a tribe dwelling in the hills. 
 
4. There I met a boy with red hair. 
 
5. Only a man with plenty of money can buy a car of such beauty and power. 
 
6. He was a young man of great promise. 7. He wore a turban made of gold. 
 
8. He ran with great speed. 
 



 

 

9. You can buy it in all places. 
 
10. He replied in a very rude manner. 
 
11. How does he live without any worries? 
 
 
 
 
 
 
 
 

 

  Writing skills  - Branding and Brand names 

 It explores the theme of branding and brand names. Students will 

have an opportunity to read and discuss the context of a text and 

create and brand their own imaginary product. 

 

It involves some discussion, reading and writing. It explores the area 

of 'brands' and the associations we have with particular brand 

names. Students will rank their favourite brand names and discuss 

what they like/dislike about them. They will read and discuss the 



 

 

context of a text about brand naming and complete related 

vocabulary building exercises. Lastly students will create and brand 

their own imaginary product which they will present to the rest of 

the class.  

       Example 

   Task 1: Reading 

    The name is the most important element of a successful brand. 

Packaging changes, advertising changes, products even change but 

brand names never change. Where do great brand names come 

from? For example,McDonald’s is a family name, Adidas was created 

from the inventor’s name Adi Dassler, Volvo means “to roll” in Latin. 

 Task 2: Discussion 

  Discuss the following questions in pairs: 

1. Why are brand names important? 

2. Name three different sources of brand names. 

3. Do you think brands are important? Why? 

4. Do you have a favourite brand? What is it and why do you like it? 

 Task 3: Mini write up 

In pairs students will  invent a new product and give it a name. 

 They will think about the following points: 

• What is special or unusual about your product? 

• Why would people want to use or buy it? 

• How does the name relate to the product? 

Once they have chosen a name for their product,they will prepare a 

short write to be given in front of the class. 



 

 

Here are some useful phrases that may help them with their 

presentation: 

• We would like to introduce our new product… 

• We chose the name… because… 

• You can use it to…  

 Some of the idea for a new product 

 A digital watch with a built in mobile phone and mini-computer 

 A new digital homework personal organiser 

 

3.Kinds of sentences – 

 

 

In writing and speaking, there are four basic kinds of sentences: 

 Declarative sentences 

 Interrogative sentences 

 Imperative sentences 

 Exclamatory sentences 

a) A declarative sentence is the most basic type of sentence. Its purpose is 

to relay information, and it is punctuated with a period. For example: 

I walked home. 

b) Interrogative sentences interrogate, or ask questions. These are direct 

questions, and they are punctuated with a question mark. For example: 

 Why haven’t you completed your work? 



 

 

c) Exclamatory sentences are like declarative sentences in that they make 

a statement instead of asking a question, but their main purpose is to 

express strong emotion. They are easily recognized because they end in 

an exclamation point instead of a period: For example 

 Wow,he just got an appraisal! 

d) Imperative sentences do not simply state a fact but rather tell someone 

to do something. These can be in the form of friendly advice, basic 

instructions or more forceful commands. For example: 

 

 Turn left at the bridge. 

 

Using Different Sentence Types to Add Variety to Writing 

Writing skill- Email writing 

   ( Activity) 

 Students will learn the rules of writing emails and will compose and send an 

email. The main focus of this lesson will be on writing semi-formal emails.  

                   Example 

 The students will send a email to a language school offering part 

time language courses . 

 

                          Some hints 

a) Do you do a part time course for school students, which helps them 

with their essay writing skills 

b) How many hours a week are the courses? 

c) What after-school activities are there? Will they help me to improve 

my communications skills? 

d) What is the actual cost of the course? Do you offer any scholarship? 

*I’m hoping to join the course soon, so if you can get back to me 

as soon as possible,it would be great. Thanks for your help. 

 

Format of a Semi formal E- mail 

 



 

 

 

 This will help them to study the difference between writing a Formal,informal 

and semi Formal email writing using different kind of sentences. 

    

     6. Parts of a sentence-  

     Every sentence can be broken into two parts  

a)   Complete Subject 

b) Complete Predicate 

The complete subject consists of simple subject ( The noun or the pronoun is 

the subject is about) and its modifiers 

 The complete predicate is made of up of verb and its modifiers. 

 

The subject of a complete sentence is who or what the sentence is about, and 

the predicate tells about that subject. 

Yesterday after lunch the students were complaining about the short recess.  

The students” are the subject (red) of the sentence. The predicate always 

includes the verb, and tells something about the subject; in this example, the 

students ( purple)“were complaining about the short recess.” 

   After explaining the concept of parts of sentence, an activity will be taken up 

to strengthen the topic. 



 

 

 Writing skills - Creating a professional portfolio 

 Finding employment can be challenging for anyone, but the job market can be 

especially tough for recent college graduates/ Undergraduates, people re-

entering the workforce after time away, or someone who has been in a 

position for a long time. Competition is stiff; the market is filled with other 

strong job candidates, too. So how can students increase their chances for 

getting a great job in the field they love? For almost everyone, it starts with a 

resume ( The following Flowchart will help the students to create a 

professional resume)

 



 

 

       (Sample of Resume writing format)

r freshers) Th  

The following link will further help the students to understand how to create 

professional resume better 

(https://youtu.be/VjdlraonW2s) 

5. Parts of speech-  A category to which a word is assigned in accordance with 

its syntactic functions. In English the main parts of speech are noun, pronoun, 

adjective, determiner, verb, adverb, preposition, conjunction, and interjection. 

The following figure represents eight parts of speech 

https://youtu.be/VjdlraonW2s


 

 

                                           

 

1.  NOUN- A noun is the name of a person, place, thing, or idea. 

      London,Flower,Happiness 

2. .PRONOUN-  A pronoun is a word used in place of a noun. 

       She, we,they, it 

 3. VERB- A verb expresses action or being. 

       Jump ,is,become 

4. ADJECTIVE -An adjective modifies or describes a noun or pronoun. 

      Pretty,old 

 5. ADVERB -An adverb modifies or describes a verb, an adjective, or another 

adverb. 

   Gently, extremely 

6. PREPOSITION -a preposition is a word placed before a noun or pronoun to 

form a phrase modifying another word in the sentence. 

By,with, 

7.  CONJUNCTION -A conjunction joins words, phrases, or clauses. T 

The young girl brought me a very long letter from the teacher, and then she 

quickly disappeared. 

8. INTERJECTION - An interjection is a word used to express emotion. 

Oh! Wow! 



 

 

The following link will help to reinforce the concept 

(https://www.youtube.com/watch?v=v9fCKTwytJA) 

 (Writing skill) 

Activity  

Adopt a word 

Students will be given templates with a heading 

Word Meaning Part of speech Example of usage 

    

 The students choose a word that they would like to adopt and do some 

research on it using the template above. 

 Each student then gives a short presentation on his or her adopted 

word until all the class has had a chance. 

 The words are then stuck to a large paper chart on the wall 

In between we  quizzes can be organised about the new words. The students 

greatly enjoy contributing words, researching and presenting.  

 This activity will help the students to streamline their thoughts and build up 

their vocabulary. 

 6.Article writing 

Article writing is the process of creating a non-fiction text about current or 

recent news, items of general interest or specific topics. 

The following figure represents the format of Article writing 

                                              * Figure 5 

https://www.youtube.com/watch?v=v9fCKTwytJA


 

 

 

 The following link will help to build up the concept 

https://youtu.be/q2197KT1iNE?list=RDQMaJwsUDCsYv4 

Example 

 You are Renu/Ronit. Write an article in 1OO-120 words for your school 

magazine on journalism as a career. 

• Hints – Journalism suitable for those who are good at language’ 

•  Ones who desire to present truth to the public 

Activity  

 Media diary 

Students write about the different ‘media’ that they have been watching or 

reading. This could include TV programmes, films at the cinema or on 

DVD,websites that they have been looking at, magazines, books, etc. This will 

help the students to have clarity about present day situations and organise 

their thoughts in a more constructive way.  

 

  5. Construction of the Paragraph 

https://youtu.be/q2197KT1iNE?list=RDQMaJwsUDCsYv4


 

 

     What is a paragraph? 

    A paragraph is a series of sentences that are organized and coherent, and 

are all related to a single topic. 

 

 

 

 

(Writing skill) 

 

Activity –   Argument essay  

 This activity will  help students organise their argument essays and so improve 

their writing.   A possible cause of the student’s  poor performance is that 

students do not know how to organise argument essays or paragraphs 

 Following points can help them( students) to write/pen down their thoughts in 

a constructive manner. 

 



 

 

 Explain the overall organisation of an argument essay to students. 

 Explain paragraph organisation. 

 Give students a list of connectives which they could use in their 

essays. Make sure that they understand the relationships that are 

implied by these connectives. 

 Give students a model argument essay. Once they have read it, 

ask them to draw a spider-diagram of the essay in the following 

way: 

 

 
 

 Firstly, students will identify the thesis.  They will write it in a circle 

in the middle of a blank piece of paper. 

 Next, identify the claims or statements that are made to support 

this thesis.  Students will  write these around the thesis. 

 Then they will identify and list the details and examples which are 

given to support each claim/statement. 

 Finally, students will write relevant connectors between the thesis 

and the claims/statements and between the claims/statements 

themselves. 



 

 

This activity aims to help student to recognise their own problems with 

paragraph construction and to identify errors, which improves their own re-

drafting skills.  

Summary: 

 A classroom environment relies heavily on the quality of communication 

taking place within it. As an instructor, taking steps towards improving the 

communication skills of students will contribute positively towards your 

classroom climate. Students with effective communication skills will be more 

likely to contribute to class discussions, will be more productive members in 

group projects, and will ultimately gain more from their experience in  the 

class. Learning and practicing writing skills help students to handle professional 

and social tensions.  
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Session 1 

Introduction to Presentation Software 

A presentation is a systematic display of information. It consists of a number of 

slides containing text, graphics, movies, sound, and graphs. Slides of a presentation 

are displayed one by one on the screen.  

 

Some common terms used in a Presentation software are: 

Slides are the individual pages of a presentation. Each slide may contain text, 

graphics, movies, and sound. 

 

Handouts are very small images of slides printed together on a sheet of paper, 

which can be given to the viewers for reference. 

 

Speaker notes are notes added to the slides as a reference for the presenter. They 

are not visible to the audience during a presentation. 

 

There are differernt sofwares like MS Powerpoint , OpenOffice Impress that can be 

used to create a presentation.  

You will learn how to create a simple presentation in OpenOffice Impress.  

OpenOffice Impress is a part of the OpenOffice.org suite. It is used for creating 

effective multimedia presentations.  

 

STARTING OPENOFFICE IMPRESS 

To start OpenOffice Impress, 

 

1. click Start All Programs  OpenOffice.org 4.1.5  OpenOffice.org 

Impress. 

2. The Presentation Wizard dialog box appears (Fig 1). Select the desired 

option from the following: 

a.  Empty presentation - Choosing this option starts a new blank 

presentation. 

b. From template – You can choose this option to create a   

presentation using a predesigned template. 

c. Open existing presentation- You can choose this option to open an 

already saved presentation that you can work on. 

3. Select Empty Presentation. 



 

 

4. Click Create. 

 

 

 

Fig 1 Presentation Wizard dialog box 

5. The Impress window screen appears with a blank presentation named Untitled 1 

by default (Fig. 2). 

 

Components of OpenOffice Impress Window 

The various components of the Impress window are shown in Figure 2. 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2 OpenOffice.org Impress window 

 

Title bar  It is located at the top and displays the name of the application and 

the name of the current document 

 

Menu bar It is located below the Title bar and contains different menu options. 

 

Standard bar It contains icons for the most commonly used commands. 

Formatting bar It contains the buttons for the commonly used formatting 

commands. 

Slide pane It is located at the extreme left and shows the thumbnail view of 

various slides in a presentation. 

Drawing bar It contains the buttons for the most commonly used drawing tools. 

Title bar Menu 

bar 

Standard bar 
Formatting 

bar 

Slide pane 

Workspace 

Drawing 

bar 

Task 

pane 

Status 

bar 



 

 

Workspace It is the main work area to create or modify individual slides 

Task pane It is positioned to the right. It contains features such as slide layout 

and slide transition to format the slides. 

 

Status bar It is positioned at the bottom and displays information such as slide 

number and zoom level. 

 

ADDING SLIDES TO A PRESENTATION 

Inserting a New Slide 

You can insert a new slide in OpenOffice.org Impress presentation in any one of 

the following ways: 

• Select Slide option from the Insert menu.(Fig 3) 

 

• Right-click on a slide in the Slide pane and select New Slide in the shortcut 

menu. (Fig 4) 

 

• Click on the Slide icon on the Standard bar. (Fig 5) 



 

 

 

 

Fig 3 Slide option of Insert menu 



 

 

 

 

Fig 4 Shortcut menu 

 

Fig 5 Slide icon on Standard bar 

 

Deleting a Slide 

To delete a slide: 

1. Select the slide in the Slide pane. 

2. Press Delete key. 

Changing the Slide Layout 

To change the slide layout in Impress, the steps are: 

1. Select the slide. 

2. Click the Slide Layout icon on the Standard bar. (Fig 6) 

3. Different slide layouts are displayed. Click on a suitable layout. 

Slide icon 



 

 

 

 

Fig 6  Selecting Slide Layout 

 

Entering text in a slide 

You can enter text in a text box in a slide. 

 
 

If you have selected a blank slide, you can insert a text box at the desired position. 

 

Inserting a Text Box 

 

You can insert a Text box using Text button on the Drawing bar. If the Drawing 

bar is not visible, select View  Toolbars Drawing to make it visible. 



 

 

 

The steps to insert a text box in a slide are: 

1. Click the Text button on the Drawing bar. 

2.  The mouse pointer changes to + the sign. 

3. Place the mouse pointer on the slide where you want to add the text box. 

4. Click and drag on the slide to draw a text box. (Fig 7 ) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 7 Drawing a Text box 

 

Editing and Formatting Text 

Like OpenOffice Writer, OpenOffice Impress includes all the basic editing features 

—copy, move, insert, delete, spell-check, etc. You can also format the text, i.e. 

change the font, style, size, font color, etc. 

 

You can use the formatting options in the Formatting bar to change the font, size 

and color of the text (fig 8) 
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Font color 



 

 

Fig 8  Formatting bar 

Applying a Slide Design 

The steps to apply a slide design are: 

1. Select Slide Design option from the Format menu (Fig 9). 

Or 

Click the Slide Design  button on the Standard bar. (Fig 10) 

Or 

Right-click on any slide in the Slide pane and select Slide Design in the shortcut 

menu. (Fig 11) 

 

 
 

Fig 9 Slide Design option from the Format menu 

 

 

 

 
 

Fig 10 Slide design button on the Standard bar 

Slide Design 



 

 

 
 

 

Fig 11 Shortcut menu 

 

2. The Slide Design dialog box appears (Fig. 12). 

 



 

 

 

Fig. 12 Slide Design dialog box 

 

3. Click the Load button. The Load Slide Design dialog box appears (Fig 13) 

 

Fig. 13 Load Slide Design dialog box 

4. Select Presentation Backgrounds in the Categories section. Select the 

desired template from the list. You can also click More to get the Preview 

box. Select the Preview checkbox (Fig. 14). 

 

 

 



 

 

 
 

Fig 14   Preview option in the Load Slide Design dialog box 

 

4. Click OK. The Slide Design dialog box reappears. 

5. Click OK. 

 

Changing Background Style 

The steps to change the slide background in OpenOffice.org 

Impress, are: 

1. Select Page option from the Format menu. (Fig 15) 

2. The Page Setup dialog box appears. 

3. Click the Background tab. 

3. Click the Fill drop-down menu arrow and choose the desired fill effect (Fig. F8-

16). 



 

 

 

Fig 15 Page option of Format menu 

 

Fig. 16 Background tab of Page Setup dialog box 

 

 

 



 

 

4. A message box appears (Fig. 17). Click Yes if you want 

to use the selected background style for all the slides. Click 

No if you want to set it only for the current slide. 

 

Fig. 17 Page Settings message box 

 

SAVING A PRESENTAT ION 

The steps to save a presentation are as follows: 

1. Select Save option from the File menu. 

Or 

Click the Save button on the Standard bar. 

Or 

Press Ctrl + Shift + S. 

2. The Save As dialog box appears. (Fig 18)Select the drive and the folder where 

you want to save the presentation. 

3. Give a name to the file in the File name text box. 

4. Click Save. Your presentation will be saved with a .odp extension. 

 



 

 

 
 

Fig 18 Save As dialog box 

 

 

CLOSING A PRESENTATION 

A presentation can be closed in any one of the following ways: 

• Select Close option from the File menu. 

• Click the Close Document button on the right side of the Menu bar. 

 

EXITING IMPRESS 

To exit OpenOffice.org Impress, the steps are: 

• Select Exit option from File menu. 

Or 

• Click the Close button at the top-right corner of the Title bar. 

 

OPENING A PRESENTATION 

To open an already saved presentation the steps are: 

1. Select Open option from the File menu. 

Or 

Click the Open button on the Standard bar. 

Or 

Press Ctrl + O. 



 

 

2. The Open dialog box appears.(Fig 19) Select the file and click Open. 

 

Fig 19 Open dialog box 

Lets Try It 

 

1. Create a new blank presentation. 

a. Add 4-5 slides on the topic Pollution’. 

b. Change the slide design. 

c. Select desired font, size, and color for the text and the heading. 

d. Save the presentation. 

 

Worksheet 

1. Name any two softwares used for creating presentation. 

______________________  

______________________  

2. What do you mean by a slide? 

_________________________________________________  

_________________________________________________  



 

 

3. Name the bar present at the top of the Impress window. 

_____________________________  

4. How can you delete a slide? 

_________________________________________________  

_________________________________________________  

_________________________________________________  

5. Write keyboard shortcut to save a presentation. 

_____________________________  

 

Session 2 

 

VIEWING AND ORGANIZING SLIDES 

A presentation in OpenOffice Impress can be viewed in following ways: 

 

Normal View 

The Normal view is the default view that is used to create and edit slides. This 

view has three panes:  

 Slide pane,  

 Task pane, and  

 the Workspace showing the current slide. 

To open the Normal view (Fig. 20): 

• Select Normal option from the View menu. 

Or 
• Click the Normal tab above the workspace. 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 20 Normal view 

 

Outline View 

The Outline view shows the Slide pane and textual content of all the slides in a 

presentation.  

The steps to open the Outline view are: (Fig. 21): 

• Select Outline option from View menu. 

Or 
• Click the Outline tab above the workspace. 

Slide 

pane 

Workspace 

Normal tab 



 

 

 

Fig. 21 Outline view 

 

Notes View 

The Notes view is used to add notes to a slide. These notes are not visible to the 

audience during the slide show. 

To enter notes in a slide (Fig. 22), follow these steps: 

1. Select Notes Page option from View menu. 

Or 

Click the Notes tab above the workspace. 

2. Select a slide from the Slide pane. 

3. Click and type the notes in the space provided. 



 

 

 

Fig. 22 Notes view 

 

Handout View 

In the Handout view, you can adjust the number of slides to be printed on each 

page. 

To open the Handout view (Fig. 23): 

• Select Handout Page option from the View menu. 

Or 

• Click the Handout tab above the workspace. 

 



 

 

 
 

Fig. 23 Handout view 

 

Slide Sorter View 

The Slide Sorter view displays miniature forms of all the slides in a presentation. 

To open the Slide Sorter view (Fig. 24): 

• Click the View button and then click Slide Sorter in the drop-down menu. 

Or 

• Click the Slide Sorter tab above the workspace. 

 

 

In this view, you can easily delete a slide, change the order of the slides,  insert a 

new slide. 



 

 

 

Fig. 24 Slide Sorter view 

Commands used in Normal and Slide Sorter views 

 

 

Action        Option 

Select consecutive multiple slides  Hold down the SHIFT key and select 

the slides. 

Select non-consecutive multiple slides  Hold down the CTRL key and select 

the slides. 

Delete slide(s)  Select slide(s) and press the DELETE 

key. 

Move slide(s)  Select the slide(s) and drag to the new 

location. 

 

 

INSERTING IMAGES 

 

You can insert image in a slide using any one of the following ways: 

 Gallery 

 From File 

 



 

 

Inserting Images Using Gallery 

The steps to insert an image using the gallery are: 

1. Select Gallery option from the Tools menu. (Fig 25) 

Or 

Click the Gallery icon on the Drawing bar. (Fig 26) 

 

 
 

 

Fig 25 Gallery option of Tools menu 

 

 

 

 

 
 

 

Fig 26 Drawing bar 

 

2.The Gallery appears above the workspace (Fig. 27). 

 

Gallery icon 



 

 

 
 

Fig 27 Gallery 

 

3. Select the theme from the left section of the gallery area. The images of 

that theme will get listed on the right side. 

4. Click on the required image. Drag the image and drop it on the slide. 

5. To close the Gallery, select Tools Gallery. 

Inserting Pictures from File 

The steps to insert a picture from a file are: 

1. Select  Insert    Picture       From File . 

2. The Insert picture dialog box appears (Fig. 28). 

2. Locate the picture you want to insert and click Open. 



 

 

 

Fig. 28 Insert picture dialog box 

 

Editing a Picture 

When you select a picture, Picture toolbar appears (Fig. 29). You can use the tools 

of this toolbar to edit the picture. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 29 Picture toolbar 

 

USING FONTWORK GALLERY 

In OpenOffice Impress, Fontwork Gallery is used to apply special effects to the 

text. 

The steps to use the Fontwork Gallery are: 

1. Click the Fontwork Gallery button on the Drawing bar. (Fig 30) 

2. The Fontwork Gallery dialog box appears (Fig. 31). 

3.  Select a Fontwork style and click OK. 

4. The selected Fontwork design will appear on the slide (Fig. 32). 

5.  Double-click the Fontwork design. The default text, i.e., Fontwork will 

appear in editing mode (Fig. 33). 

 

 

 

 

Formatting bar 
Graphics Side 

bar 



 

 

 

 

 

Fig  30 Drawing bar 

 

Fig. 31 Fontwork Gallery dialog box 

 

Fontwork Gallery 



 

 

 

Fig. 32 Fontwork design on the slide 

 

Fig. 33 Editing Fontwork text 

 

6. Change the text and then click anywhere in the document. (Fig 34) 

7. Using the Fontwork bar (Fig. 35), you can change the style of the text, 

letter height, etc. 

 

 

Fig 34 text on the Slide 



 

 

 

Fig. 35 Fontwork bar 

INSERTING SHAPES 

You can insert  basic pre-defined shapes a slide. The steps to add the shapes are: 

 

1. Click the arrow next to the Symbol Shapes option (Fig. 36) on the Drawing 

bar. 

2. Select the desired shape. 

3.  Click and drag on the slide to draw the shape. 

4. Similarly, you can use the options available on the Drawing bar to draw many 

other shapes, arrows, callouts, etc. (Fig 37) 

 

 

Fig 36  Symbols option on Drawing bar 



 

 

 

Fig 37 Shapes drawn on a slide 

 

Editing Shapes 

The inserted shapes can be edited using the Line and Filling bar. This bar appears 

when you select a shape. The various options of the toolbar are shown in Figure 

38. 
 

 

 

 

 

 

 

Fig. 38 Line and Filling bar 
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Lets Try It 

1. Create a new presentation of 4-5 slides on the topic ‘Activities in My 

School’. 

a. Use Fontwork gallery to write the headings. 

b. Choose suitable font, size and color for the text. 

c. Apply suitable background to the slides. 

d. Insert suitable pictures in each slide. 

2. Create a new blank presentation for children of Primary level to teach them 

about different shapes. 

a. Use FontWork to write the headings. 

b. Choose suitable font, font style, size and color for the text. 

c. Apply suitable background to the slides. 

d. Insert different shapes from the Drawing bar. 

e. Edit these shapes to change their fill and line styles and color. 

f. View the presentation in the following views 

i. Normal view 

ii. Slide Sorter view 

g. Change the order of slides in the Slide Sorter view. 

 

Worksheet 

1. How can you perform the following actions in Slide Sorter view? 

a. Select consecutive multiple slides 

b. Select non-consecutive multiple slides 

c. Delete slides 

2. Name the view used to see all the slides in a miniature form. 

3. Name the bar that has option to insert basic shapes. 

4. Name the two ways in which you can insert pictures in a slide. 

 

Session 3 

INSERTING SOUND OR MOVIES 

You can add sound and video files in a presentation created in Impress. The steps 

are: 

1. Select the slide. 

2. Select Movie and Sound option from the Insert menu. (Fig 39) 



 

 

3. The Insert Movie and Sound dialog box will appear (Fig. 40).  

4. Select the desired sound/movie file and click Open. 

 

Fig 39 Movie and Sound option of Insert menu 

 

Fig. 40 Insert Movie and Sound dialog box 



 

 

3. If you insert a sound file, the sound (  ) icon appears on the slide. 

4. If you insert a movie file, the movie appears on the slide. 

 

SLIDE TRANSITION 

The steps to apply transition effects to a slide are: 

1. Select the slide. 

2. Select Slide Transition option from the Slide Show menu. (Fig 41) 

Or 

Click the Slide Transition tab in the Task pane. 

3. The Slide Transition panel will appear in the Task pane (42).  

4. The steps to apply transition are: 

a. Select a slide transition effect 

b. Select the speed of transition 

c. Select sound 

d. Select a method to move to the next slide. 

e. Select Automatic Preview to see the preview of the current slide. 

f. Click Apply to all slides to apply transition to all slides 

 

Fig 41 Slide Show menu 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 42 Slide transition tab 

 

CUSTOM ANIMATION EFFECTS 

The steps to apply custom animation effects to an object are: 

1. Select the slide.  

2. Select the object to which you want to apply custom animation. 

3. Select Custom Animation option from Slide Show menu (Fig 41).  

4. The Custom Animation panel appears in the Task pane (Fig. 43). 

 

 

 

Slide transition 

tab 



 

 

 

Fig. 43 Custom Animation panel 

3. Click the Add button under Modify effect. 

4. The Custom Animation dialog box appears with the Entrance tab selected 

(Fig. 44). Choose the desired effect and adjust the speed.  

 

 



 

 

 
 

Fig 44 Custom Animation dialog box 

 

The other tabs of this dialog box and their options are as follows: 

Emphasis tab This tab allows you to highlight the object on the slide. 

Exit The options under this tab allow you to select how the object will leave the 

slide. 

Motion Paths This tab helps you to select the motion path that the object will  

follow on the slide. 

Misc Effects This tab has the commands to control a media file, i.e., an audio or 

a video file. You can select options for starting, pausing, or stopping the video or 

sound file. 

5. Click OK. 

6. Repeat the above steps for other objects on the slides. 

 

 



 

 

Changing the Order of Animation 

The steps to change the order of animations are as follows: 

1. In the Custom Animation panel, select the animation whose order you want to 

change. 

2. Use the Change Order buttons to move the animation up or down. 

 

 

Removing Animation Effects 

The steps to remove an animation are as follows: 

1. In the Custom Animation panel, click the animation effect you want to remove. 

2. Click the Remove button 

 

SLIDE SHOW 

The Slide Show view is used to display a presentation slide-by-slide in full screen 

mode. 

 

You can run a slide show in any one of the following ways: 

• Press F5. 

• Click the Slide Show button on the Standard bar. 

• Click the View button and then click Slide Show in the drop-down menu. 

• Click the Slide Show button and then click Slide Show in the drop-down menu. 

 

 During a slide show, you can move to the next slide in the following ways: 

• Click the mouse button. 

Or 

• Press ENTER or the spacebar. 

 

PRINTING A PRESENTATION 

The steps to print a presentation are as follows: 

1. Select Print option from the File menu (Fig 45). 

2.  The Print dialog box appears. (Fig 46) 

a. Select a printer. 

b. Select number of copies to be printed. 

c. Select the slides to be printed. 

d. Click the Print button. 

 



 

 

 

 

 

Fig 45  File menu 

 

 



 

 

Fig. 46 Print dialog box 

 

 

Lets Try IT 

 

1. Create a presentation of 7-8 slides on the topic ‘Natural Resources’ 

a. Choose suitable font, size and color for the text. 

b. Write headings using FontWork. 

c. Insert suitable pictures in each slide 

d. Insert a video related to the topic in the last slide. 

e. Apply custom animation to the objects on the slide. 

f. Apply Slide transition to the slides. 

g. Print the handouts of the slides. 

 

Worksheet 

1. Custom animation is applied to the _____________________. 

2. Slide transition is applied to the _____________________  

3. How can you insert an audio in a slide? 

____________________________________________  

____________________________________________  

____________________________________________  

4. Name the menu and the option used to print slides of a presentation. 

________________________________________  

5. Mention any two ways to run a slide show. 

___________________________________ 



 

 

 

Unit 1 Spreadsheet Software 

Session 1  Introduction to Spreadsheet software 

 

OpenOffice Calc is a spreadsheet program, a part of the free OpenOffice suite. The 

program is easy to use and contains most of the commonly used features found in 

commercial spreadsheet programs. 

OpenOffice Calc is software that helps in performing calculations using formulae 

and in analysing data.  

 

ore 

 

ADVANTAGES OF SPREADSHEETS 

Spreadsheet programs have become very popular because of the following 

features: 

• Built-in functions make calculations easier, faster, and more accurate. 

• Large volumes of data can be easily handled and manipulated. 

• Data can be exported to or imported from other software. 

• Data can be easily represented in pictorial form like graphs or charts. 

• Formulae are automatically recalculated whenever underlying data values are 

changed. 

 

STARTING OpenOffice Calc 

To start OpenOffice Calc: 

 

1. Click Start  All Programs  OpenOffice 4.1.5  OpenOffice Calc. (Fig 

1) 

2. A spreadsheet workbook named Untitled1 opens up in an OpenOffice Calc 

application window (Fig. 2). 

 

 

 



 

 

 
 

Fig 1 Starting OpenOffice Calc 
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Fig. 2  OpenOffice Calc worksheet 

 

Components of a Calc Screen 

 

Title bar The title bar is located at the top of the Calc window. It displays the 

name of the workbook on which you are currently working. A workbook is a 

collection of one or more worksheets. The right side of the title bar contains the 

Minimize, Restore Down or Maximize, and Close buttons. 

 

 

Menu bar  The menu bar has commands like File , Edit, etc. Clicking on each 

menu option displays a list of commands. 

 

Standard bar  This bar contains icons (buttons) to provide quick access to 

commands such as New, Open, Print, Copy, and Paste etc.  

 

Formatting bar It has buttons and drop-down menus that allow you to select a 

formatting option like, font, font color, alignment, number format, border, and 

background color. 

 

Formula bar It contains the Name Box and a long white box, known as the Input 

line. 

 

Name Box  It is present to the left of the Formula bar and displays the address of 

the selected cell. 

 

The rest of the window contains the spreadsheet. It is divided into rows that have a 

number at the left of each row, and columns with a letter at the top of each column. 

 

Worksheet tabs A workbook, by default, opens three worksheets named as 

Sheet1, Sheet2, and Sheet3. You can click any sheet tab to open that 

worksheet. To insert a new worksheet, the steps are: 

1. Clicking the empty area after the sheet tab. 

2.  The Insert Sheet dialog box appears. (Fig 3) 

3. Select the required option and click OK 

 

 

 

 

 



 

 

 

 

(Fig. 3).   Fig 3 Inserting a new sheet 

 

 

Rows and columns A worksheet in OpenOffice 4.1.5 Calc has 1,048,576 rows and 

1,024 columns. The rows are numbered from top to bottom along the left edge of 

the worksheet as 1, 2, and so on. 

Columns are labelled from left to right with letters A…Z, AA…AZ, 

A…BZ…AAA…AAZ, ABA…ABZ… 

AMA…AMJ. 

 

Cell A cell is formed by the intersection of a row and a column. Each cell has a 

unique address which is formed by the intersection of row number and column 

letter. For example,  a cell formed by intersection of column F and row 5 will have 

address F5. 

 

 

Data Types 

You can enter numbers, text, and formulas in a cell. 

 

Entering data 

To enter data in a cell,  

Click blank 

area to add 

more sheet 



 

 

1. Select the cell. 

2. Type the content. 

3. Press ENTER key. 

 

To cancel the data you have entered before pressing the ENTER key, press the 

ESC key. 

 

Creating a New Workbook 

The steps to create a new Calc workbook are: 

1. Select File   New  Spreadsheet (Fig. 4). 

Or 

Click the New Document drop-down menu arrow on the Standard bar and select 

Spreadsheet. (Fig 5) 

Or 

Press CTRL + N. 

 

 

 
Fig. 4 New option in the File menu 



 

 

 

 

 

 

 

 

 

Fig 5  New button on Standard bar 

 

Saving a Workbook 

To save a workbook: 

1. Select Save option from File menu. 

Or 

Click the Save icon on the Standard bar.2 

Or 

Press CTRL + S. 

 

 

If you are saving a workbook for the first time, a Save As dialog box will appear 

(Fig. 6). 

New button on 

Standard bar 



 

 

2. Type a file name and choose a location to save the file. Notice that the file 

extension is .ods. 

3. If you want to save the file in the Microsoft Excel file format, change 

the Save as type to Microsoft Excel 97/2000/XP (.xls). (Fig 7) 

 

 

 
Fig. 6 Save As dialog box 

 



 

 

 
 

Fig. 7 Save As dialog box 

 

SELECTING CELLS 

 

Before performing any operation, like, making text bold, changing text color, etc, 

on a range of cells, you need to select the range. 

A range is a rectangular block of contiguous cells, i.e., cells that touch each other, 

especially along a line.  

You can select range of cells in any one of the following ways: 

 

 Using the mouse 

 Using the keyboard 

 

 

 

Using the mouse 
To select a range of cells using the mouse, the steps are: 

1. Click the cell you wish to start your selection from. 

Select Save 

as type 



 

 

2. Bring the mouse pointer to the bottom right corner on the black square. Click and hold the left 

mouse button down, drag the mouse pointer (a thick plus sign will appear) to the diagonally 

opposite corner cell.  

For example, if the range A1 to D3 is to be selected, place the mouse pointer at cell A1. Hold the 

left mouse button down and drag it to the cell D3. The range A1 to D3 is represented as A1:D3. 

When you select the range, all the cells appear highlighted (Fig. 8). 

 

 

 
 

 

 
Fig 8 Selecting range using mouse 

 

 

Using the Keyboard 

To select a range of cells using the keyboard, do the following: 

1. Place the cell pointer at one of the corner cells of the range to be selected. 

2. Press the SHIFT key and move to the diagonally opposite corner cell using the 

arrow keys. 

3. Release the SHIFT key when the required range has been selected. 

 

 

 

Selecting Multiple Ranges Simultaneously 

To select multiple ranges, do the following: 

1. Select the first range of cells. 

2. Hold the CTRL key and select another range of cells. 

3. Repeat step 2 to select more ranges if required (Fig. 9). 



 

 

 
Fig 9 selecting multiple range of cells 

 

 

Selecting the entire row  
To select the entire row in which the cell pointer is positioned, do any one of the 

following: 

 

SHIFT + SPACEBAR  

 

Or 

 

click the row heading. 

 

Selecting the entire column  

To select the entire column in which the cell pointer is positioned, do any one of 

the following: 

 

CTRL + SPACEBAR 

 Or,  

 

click the column heading. 

 

Selecting the entire worksheet  
To select the entire worksheet: 

 

CTRL + A  



 

 

Or,  

 

Click the blank button (called the Select All button) at the junction of the row and 

column headers.(Fig 10) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 10 Select All button 

 

EDIT COMMANDS 

 

After typing in a cell, you may need to change the entire content or do some partial 

modifications. This can be done in any one of the following ways: 

 

 By overtyping, i.e., changing the content completely 

 By partially modifying the content 

 

Overtyping 

 

To edit a cell by overtyping: 

1. Select the cell. 

2. Type the new content. 

3. Press ENTER key. 

 

 

Select All 

button 



 

 

Partial Modification 

 

If some minor modification is required in a cell content: 

1. Select the cell. 

2. Click the Formula bar. 

OR 

Press F2 

Or 

Double-click in the cell. 

3. Now, edit the content in the formula bar or in the cell. 

4. Press the ENTER key or click Enter button on the Formula bar. 

 

 

Undo and Redo 

The undo command allows you to reverse the last action you have performed. To 

undo the last action, you can do any one of the following: 

 

Click the Undo button on the Standard bar. (Fig 11) 

Or 

Select Undo option from the Edit menu.(Fig 12). 

Or 

Press CTRL + Z. 

 

 

 

 

 

 

 

Fig 11 Undo button on Standard bar 
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Fig 12 Undo option of Edit menu 

 

The redo command is activated only after you have undone an action. 

To redo an action that you undid, you can do one of the following: 

 

Click the Redo button on the Standard bar. 

Or 

Click the Edit button and then click Redo in the drop-down menu. 

Or 

Press CTRL + Y. 

 

Copying Cell Contents 

 

To copy cell contents in Calc, the steps are: 

1. Select the cell(s) that contain(s) the data you want to copy. 

2. Select Copy option from the Edit menu. (Fig 13) 

Or 

Click the Copy button on the Standard bar. (Fig 14) 

Or 

Press CTRL + C to copy the data. 



 

 

3. Click on the cell(s) where you want to paste the data. 

4. Select Paste option from the Edit menu. 

Or 

Click the Paste button on the Standard bar. 

Or 

Press CTRL + V. 

 

 

 
 

Fig 13 Copy option of Edit menu 

 

 

 

 

 

 

 

 

Fig 14  Standard bar 

 

Cut Copy paste 



 

 

Moving Cell Contents 

 

To move cell contents from one cell to another in Calc, the steps are: 

1. Select the cell that contains the data you want to cut. 

2. Select Cut option from the Edit menu. 

Or 

Click the  Cut button on the Standard bar. 

Or 

Press CTRL + X to cut the data. 

3. Click on the cell where you want to paste the data. 

4. Select Paste option from the Edit menu. 

Or 

Click the Paste button on the Standard bar. 

Or 

Press CTRL + V. 

 

Inserting Cells 

To insert cells, the steps are: 

1. Select the range of cells where you want to insert a block of cells. 

2. Select Cells option from the  Insert menu.(Fig 15) 

3. The Insert Cells dialog box appears (Fig. 16).  

4. Select the appropriate option and click OK. 

 

 

 



 

 

 

 

 

Fig 15 Cells option of Insert menu 

 

 
 

Fig. 16  Insert Cells dialog box 

 

 

 

Deleting Cells 

To delete cells, the steps are: 

1. Select the range of cells where you want to delete a block of cells. 

2. Select Delete Cells option from the Edit menu. (Fig 17) 

3. The Delete Cells dialog box appears (Fig. 18).  

4. Select the appropriate option and click OK. 

 

 



 

 

 
 

Fig 17 Delete Cells option of Edit menu 

 
 

 

Fig. 18 Delete Cells dialog box 

 

 



 

 

Inserting Rows  

The steps to insert rows are: 

1. Select the row where you want to insert a new row. 

2. Select Rows option from the Insert menu. 

Or 

Right-click the row header and select Insert Rows in the shortcut menu.(Fig 

19) 

 

A new row is inserted above the selected/highlighted row. Cells in the new row are 

formatted similar to the corresponding cells in the row before which the new row is 

inserted. 

Multiple rows can be inserted at once by selecting multiple rows using the 

CTRL key or by dragging the mouse while holding down the left mouse button. 

 

 

 
 

Fig 19 Insert Rows option in Shortcut 

 

Inserting Columns 

To insert columns, the steps are: 

1. Select the column where you want to insert a new column. 

2. Select Columns option from the Insert menu. 

Or 

Right-click the column header and select Insert Columns in the shortcut 

menu. (Fig 20) 



 

 

When you insert a new column, it is inserted to the left of the selected/highlighted 

column. Cells in the new column are formatted similar to the corresponding cells 

in the column to the left of which the new column or row is inserted. 

Multiple columns can be inserted at once by selecting multiple columns using the 

CTRL key or by dragging the mouse while holding down the left mouse button. 

 

 
 

Fig 20 Insert Columns option 

 

 

Deleting Rows  

 

To delete rows, the steps are: 

1. Select the row to be deleted. 

2. Right-click on the selected column header. 

3. Select Delete Rows option in the shortcut menu. (Fig 19) 

To delete multiple rows, select them using the CTRL key, or by dragging the 

mouse while holding the left mouse button. 

 

Deleting Columns 

To delete columns, the steps are: 

1. Select the column to be deleted. 

2. Right-click on the selected column header. 

3. Select Delete Columns in the shortcut menu. 

To delete multiple columns, select them using the CTRL key, or by dragging the 

mouse while holding the left mouse button. 



 

 

 

Instead of deleting a row or column, you may want to delete the contents of the 

cells but keep the empty row or column. This can be done in the following manner: 

1. Select the cell(s), the contents of which you want to delete. 

2. Press the DELETE key. 

Or 

Select Delete Contents option of Edit menu. 

3. The Delete Contents dialog box appears (Fig. 21). 

3. Check the boxes of the kind of data you want to delete (e.g., checking Formats 

will remove the formatting changes such as bold, italics, font colors, and borders). 

4. Click OK. 

 

 

 
 

 

Fig. 21 Delete Contents dialog box 

 

Changing Row Height You can change the row height in a Calc worksheet in any 

of the following ways: 

 

• Drag the divider below the row (Fig 22). 

 

• To fit the row height to the cell contents, double-click the divider. 

• Select Format  Row  Height (Fig 23). The Row Height dialog box appears 

(Fig. 24). Enter the value for row height in the Height spinbox. 

 



 

 

 
Fig 22 Changing row height 

 

 
 

Fig 23 Format menu 

 

 
Fig. 24 Row Height dialog box 



 

 

 

Changing Column Width 

You can change the column width in a Calc worksheet in any of the following 

ways: 

• Drag the divider to the right of the column header (Fig 25). 

 

2• To fit the column width to the cell contents, double-click the divider. 

• To change the column width, select Format Column  Width. (Fig 26) The 

Column Width dialog box appears (Fig. 27). Enter the value for column width in 

the Width spinbox. 

 

 
 

 

Fig 25 Changing column width 

 



 

 

 
Fig 26 Format menu 

 

 
Fig. 27 Column width dialog box 

 

 

Selecting the Default value checkbox automatically adjusts the row height or 

column width based on the current font. 

 

 

FORMATTING DATA 

The options for formatting data/text are available on the Formatting bar (Fig 28). 

The use of each of the options is explained below the figure. 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

Fig. 28  Formatting bar 

 

Font formatting options can also be accessed by selecting Format  Cells. The 

Format Cells dialog box appears.(Fig 29) It has seven tabs with various options 

for font formatting. 

a. Click the Numbers tab (Fig 29). You can select the desired Number format. 

 

 
Fig 29 Format Cells dialog box 
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b. Click the Font tab (Fig 30). You can select font, font size, etc. from this tab. 

 

 
 

Fig 30  Font tab 

 

c. Click Font Effects tab (Fig 31).  

 



 

 

 
Fig 31 Font Effects tab 

 

d. Click Alignment tab (Fig 32). 

 

 
 

 

Fig 32 Alignment tab 

e. Click Borders tab (Fig 33). 

 



 

 

 

 
 

Fig 33 Borders tab 

 

f. Click Background tab (Fig 34). 

 

 
 



 

 

 

Fig 34 Background tab  

 

Using Autofill 

 

The AutoFill feature of Calc allows you to fill a range of cells with a series of data 

without typing all of it.  

The predefined series that can be filled in Calc using AutoFill are: 

 months of the year  

 days of the week.  

 

To use AutoFill for a series the steps are: 

1. Select the cell, say A1, which has the data, say, Monday (Fig. 35). 

You want to fill the rest of the days of the week in the column. 

2. Move the mouse pointer to the small black square at the lower-right corner of 

the cell. This square is called the fill handle.  

3.When you point to the fill handle, the mouse pointer changes to a cross shape. 

4. Drag to enclose the area you want to fill (Fig. 36). 

4. Release the mouse button. The cells enclosed will be filled with days of the 

week (Fig. 37). 

 

 
 

Fig 35 Selecting cell 

 



 

 

 
 

Fig 36 Dragging to fill the list 

 

 

 
Fig 37 Filled series 

 

You can also fill a cell range with a series of numbers. The steps are: 

1. Type the first two values of the series in two adjacent cells. (Fig 38) 

2. Select the two cells. Click the fill handle in the lower-right corner of 

the selected cells. 

3. Drag it to enclose the area you want to fill (Fig. 39). 

4. Release the mouse button (Fig. 40). AutoFill uses the difference between the 

first two numbers and keeps adding it to the last number. So the range gets filled 

automatically. 

 

 



 

 

 
Fig 38 Selecting cells 

 
 

Fig 39 Dragging the autofill handle 

 

 
Fig 40 Filled list 



 

 

 

 

Lets Try It 

 

1. Create the following series in Calc 

 

 
 

 

2. Create the following Worksheet and perform the following commands: 

 

 
a. Merge the cells of the first row 



 

 

b. Change the row height 

c. Change the column width 

d. Choose suitable alignment for the text and numbers 

e. Apply border to the cells . 

f. Apply background color to the cells of first row. 

g. Choose suitable font, size and color for the content in the worksheet. 

h. Insert a column before ‘Price’ and enter the company name for the products. 

Worksheet 

 

1. Mention two ways in which you can select the entire worksheet. 

________________________  

________________________  

2. How will you refer to the range of cells from A1 to B5? 

__________________________  

3. What is the address of the cell formed by the intersection of column 4 and 

row 7? 

__________________________  

4. Name the cell after cell z? 

________________________  

5. Name the menu that has option to save a file. 

______________________  

6. How can you select multiple ranges of cells simultaneously? 

_____________________________  

_______________________________  

____________________________  

_____________________________  

7. Write keyboard shortcut for Undo and Redo commands. 

___________________________  

___________________________  

8. Which feature of Calc will help you to create a series of week days and 

multiples of five? 

________________________  

9. How can you quickly change the row height? 

____________________________________  

__________________________________  

10. By default how many worksheets are there in a Calc workbook? 

_______________________ 

 

Formula in a Worksheet 



 

 

Formulae are used to calculate results through arithmetic operations. A formula in 

Calc always starts with an equal to (=) sign. 

 

The data in a formula consists of one or a combination of the following: 

 

Value Numeric (e.g., 45) or string (e.g., “Smiling”) 

Cell Address B4, A2:C6 

Function SUM, AVERAGE, MIN, MAX, etc. 

Operator +, -, *, /, >, =, etc. 

Parenthesis To control the left to right order of precedence in a formula (e.g., = 

(B2*B3)*2) 

A formula is a sequence of values, cell references, functions, and/or operators that 

is contained in a cell which produces new values from existing values. 

To enter a formula: 

1. Select a cell and enter the formula directly in the cell or in the Formula bar. 

2. Press ENTER key.  

3. The cell will show the result of the formula and not the formula itself. You 

can see the formula in the Formula bar when the cell is selected. (Fig 41) 

 

 

 

 
 

Fig 41 Formula in Formula bar 

Formula in Formula bar 

Selected 

cell 



 

 

TEXT FORMULAE 

A text string or a text value is a sequence of characters. You can join two strings 

together. This is called concatenation. We use the ampersand (&) character to 

concatenate strings. 

For example, if you type = “Keep” & “ “ & “Smiling” in a cell and press 

ENTER, you will see the result as Keep Smiling. 

 

You cannot do operations such as subtraction, multiplication, and division on 

strings.  
 

NUMERIC FORMULAE 

In numeric formulae, you have to make use of operators. The results are calculated 

based on the order of precedence of the operators. 
 

 

Mathematical Operators Used in Formulae 

The mathematical operators used in Calc and their order of evaluation in formulae 

is given below: 

 
Operation   Operator  Order of evaluation  Formula  Result 

Exponent    ^   1    = 2 ^ 3   8 

Multiplication   *   2    = 3 * 5   15 

Division    /   2    = 9/ 3    3 

Addition    +   3    = 12 + 15   27 

Subtraction    -   3    = 18 - 15   3 

 

 

Order of evaluation 

1. Any operation contained within brackets will be carried out first 

2. Then any exponent.  

3. Then follow division and multiplication operations. Multiplication and 

division are given equal importance. They are carried out in the order they 

occur in the formula, from left to right. Whichever appears first in the 

formula is carried out first.  

4. After that, addition and subtraction operations are given equal importance. 

They are also carried out in the order they occur in the formula, from left to 

right. 

Following are some examples of how Calc evaluates formulae. 

Formula    Output 

= (3 + 7) * 2    20 



 

 

= 4 * 3 + 5    17 

= 3 + 3 ^ 2     12 

= 5 + 3 * 4 – 2   15 

= 6 + 14/2 * 3 - 4   23 

 

ERROR RESULTS 

Sometimes a formula displays an error result rather than a proper value. This 

happens when the formula or data has a problem and Calc cannot evaluate it. 

 

Some common errors are shown below: 

 

Error    Reason 

#####   The column is not wide enough to display the value. 

#DIV/0!   The formula contains an invalid operation, i.e., division by 

zero. 

#VALUE!   The formula has invalid argument, e.g., text in a cell where 

numeric value is required. 

 

Cell and Range References 

A cell reference identifies a cell or a range of cells. Each cell in the worksheet has 

a unique address formed by the combination of its intersecting row and column. 

When a cell address is referred to in a formula, it is called cell referencing.  

Consider the following examples: 

 

Cell or a Range of Cells       Reference 

The cell in column B and row 4       B4 

All cells in row 5          5:5 

All cells in rows 5 through 9        5:9 

All cells in column B         B:B 

The range of cells in column F and rows 1 through 7    F1:F7 

The range of cells in row 5 and columns C through E    C5:E5 

All cells in columns C through G       C:G 

The range of cells in columns B through G and rows 4 through 8 B4:G8 

 

 

ENTERING A FORMULA 

All formulae in OpenOffice Calc begin with an equal to (=) sign. A formula can 

contain number, text, arithmetic operators (+, -, *, /), or functions. The order of 

precedence is already discussed. 

 



 

 

Consider the following worksheet. 

 
 

Fig 42 Worksheet 

 

To find the total marks: 

1. Select cell D3. 

2. Type the formula =B3+C3. 

3. To copy this formula in other cells: 

a. Select cell D3. 

b. Click the AutoFill handle and drag till cell D6. (Fig 43) 

 

 
 

Fig 43 Copying formula 

 

c. The formula copied in cell D4 will be =B4+C4. 

d. The formula copied in cell D5 will be =B5+C5. 



 

 

e. The formula copied in cell D6 will be =B6+C6. 

 

 

SUM 

You have already learnt how to find total using the formula. You can also obtain 

the sum of the values in a range of cells by: 

• Clicking the Sum button on the Formula bar (Fig 44) 

• Using the SUM() function 

 

 

 

 
 

Fig 44 Formula bar 

 

Let us consider an example. 

1. Consider the worksheet shown in Figure 45. 

 
Fig 45 Creating a worksheet 

 

2. Select the cell D2. 

3. Click the Sum button on the Formula bar. Notice it will select the range 

A2:C2. (Fig 46). 

SUM button 



 

 

 
 

 

Fig 46 

 

4. Select the correct range B2:D2 or type the correct range (Fig 47). 

 
 

Fig 47 

 

5. Press ENTER (Fig. 48) to perform the operation. The sum of the range 

B2:C2 will appear in cell D2. 

 



 

 

 
 

Fig 48  

4. Select cell D2 and using the AutoFill handle, drag the formula through D7. The 

respective sums will appear in the respective cells.(Fig 49) 

 

 

 
 

Fig 49 

 

 

FUNCTIONS 

 
Functions are predefined formulae that perform calculations using specific values called 
arguments. 
 

 



 

 

The format of writing any function in Calc is: 

=function_name(Argument1;Argument2; Argument3;…..) 

 

 

Arguments These are the values passed to a function so that the function carries 

out the intended calculation or manipulation to give results. Arguments can be 

constants, formulae, or function. 

 

SUM function 

SUM function is used to find total of numbers in a range of cells. 

For example: 

 

Formula      Result 

=SUM(5;6;12)     23 

=SUM(A1;B1;C1) where A1, B1        49 

 and C1 contain the values 12, 23 

 and 14 respectively  

 

 

AVERAGE Function 

Average function is used to find the average of numbers in a range of cell. 

For example: 

Formula      Result 

=AVERAGE(3;6;9)    6 

=AVERAGE(A1;B1;C1)   5 

 where A1, B1 and C1 contain the 

 values 4, 5 and 6 respectively  

 

 

COUNT Function 

The COUNT function is used to count the number of numeric values in a range of 

cells. 

For example: 

 

Formula      Result 

=COUNT(5;8;14;19)     4 

=COUNT(A1:A10) 

 

MAX Function 



 

 

The MAX function is used to find the maximum of numbers in a given range of 

cells. 

For example, 

 

Formula      Result 

 

=MAX(74;102;134)     134 

=MAX(A1;B1;C1)  

Or 

=MAX (A1:C1)    6 

 where A1, B1 and C1 contain the 

 values 4, 5 and 6 respectively 

 

MIN Function 

The MIN function is used to find the minimum of values in the given range of 

cells. 

For example; 

Formula      Result 

 

=MIN(74;102;134)     74 

=MIN(A1;B1;C1)  

Or 

=MIN (A1:C1)     4 

 where A1, B1 and C1 contain the 

 values 4, 5 and 6 respectively 

 

 

PRINTING A WORKSHEET 

Select  File  Page Preview (Fig 50) to view a worksheet so as to get an idea of 

how it will look when printed. 

 

or  

 

Click the Page Preview button on the Standard bar (Fig 51). 

 



 

 

 
 

 

Fig 50 

 

 

 

 

 

 
Fig 51 

 

 

 

 To print a worksheet, the steps are: 

1. Click File  Print. 

2. The Print dialog box will appear (Fig. 52). 

3. Select the printer, the range to be printed, and the number of copies. 

4. Click the Print button.  

 

Page Preview 



 

 

 

To quickly print without getting the Print dialog box, click the Print button on the 

Standard bar. (Fig 51) 

 
 

Fig. 52 Print dialog box 

 

Lets Try it 

 

1. Create the following worksheet and calculate total and percentage for each 

student. 

 
 

 

2. Create the following worksheet. Calculate area and perimeter of square. 



 

 

 
 

 

3. Create the following worksheet. Calculate area and perimeter of rectangle. 

 

 
 

4. Create the following worksheet and perform calculations using functions in 

Calc. 



 

 

 
 

Worksheet 

 

1. How will you refer to a cell in column B and row 3? 

2. How will you refer to range of cells in row 5? 

3. How will you refer to range of cells in column D through F and rows 3 

through 8? 

4. Write mathematical operator for the following operation: 

a. Multiplication 

b. Division 

5. If formula in cell C3 is =A3+B3, what formula will be copied in cell D3? 

6. How will you write a function to find average of numbers 5, 12, and 17? 

7. Name the function used to find total of numbers in the range of cells A1 to 

A10. 

8. Name the menu used to print the document. 

9. What error will you get if the column is not wide enough to display the 

value? 

10. What happens if you write the formula =45/0 in cell A1? 

 

Session 3 

 

SORTING DATA 

Once you have entered data and applied relevant formulas in a worksheet, you can 

change the order in which the data is present in the cells. This is called sorting of 

data. 

 



 

 

Sorting on numerical and textual values is a one of the main features of any 

spreadsheet software. In Calc, sorting can be done in the following manner. 

 

Sorting on One Column 

1. Enter data in a worksheet (Fig. 53). 

2. Select any cell, say C1. 

3. Click the Data option from the Sort menu (Fig. 54) 

 

 
 

Fig. 53 Data in worksheet 

 

 



 

 

 
 

Fig. 54 Sort option in the Data menu 

 

 

3. The Sort dialog box appears (Fig. 55). Notice that column Marks appears 

under Sort by section. 

4. Select the Descending option under Sort by and click OK. 

5. The data in column Marks is sorted in descending order.(Fig 56) 

 

 

 
 



 

 

Fig 55 Sort dialog box 

 

 
 

 

Fig 56 Data arranges in descending order of Marks 

 

You can also sort the data on one column is by using the sorting icons on the 

Standard bar.  

On the Standard bar, click(Fig 57) 

• The Sort Ascending button to sort the data in ascending order. 

• The Sort Descending button to sort the data in descending order. 

 

 

 

 

 
 

Fig 57 Sort buttons on Standard bar 

 

Sorting on Multiple Columns 

You can sort the data on multiple columns.  

1. Consider the following worksheet. (Fig 58) 

 

 

 

Sort 

Ascending 

Sort 

Descending 



 

 

 
 

Fig 58 Worksheet 

 

2. Select cell, say C1. 

3. Select Sort option from Data menu. 

4. The Sort dialog box appears. 

5. The Sort Criteria tab on the Sort dialog box has options to sort the data on 

multiple columns. 

6. Select the options as shown in Figure 59.  

7. The data is sorted in descending order of column Total Sale, and where total 

sale is same, sorting is done in ascending order of column Salesman Name. 

(Fig 60) 

 



 

 

 
 

 

Fig. 59 Multiple columns selected in the Sort dialog box 

 

 
 

Fig 60 Data sorted on multiple columns 

 

 

FILTERING DATA 



 

 

Filtering is a quick and easy way to find and work with selected data based on the 

criteria you specify. The filter feature selectively blocks out the data you do not 

want to see and displays only the rows or columns that meet the conditions or 

criteria you specify. Sorting rearranges the range of cells but filtering only 

hides temporarily the rows/columns you do not want. 
 

Different ways in which filtering can be done in Clac are: 

 AutoFilter 

 Standard Filter 

 

AutoFilter 

To apply AutoFilter in a worksheet, the steps are: 

1. Select cell, say, A1. 

2. Select Data    Filter   AutoFilter (Fig. 61).  

3. A drop-down menu arrows appear in each column heading (Fig 62). 

 

 
 

Fig. 61 AutoFilter option in the Data menu 

 

 



 

 

 
 

 

 

Fig. 62 Drop-down menu arrows in column Headings 

 

4. Click the drop-down menu arrow for Total Sales and select an item (Fig 

63).  

5. Only those rows whose contents meet the filter criteria are displayed.  (Fig 

64) 

a. To display all the records again, select the All option in the filter drop-

down menu. 

b. Select Top 10 to display the highest 10 values. 

 

 



 

 

 
 

Fig. 63 Drop-down menu for Total 

 

 

Standard Filter 

To apply standard filter in your worksheet, the steps are: 

1. Select  Data    Filter   Standard Filter. (Fig. 61).  

2. The Standard Filter dialog box appears (Fig. 64).  

a. You can use the dialog box to connect multiple conditions with either a 

logical AND or a logical OR operator. 

3. Select the options in the Standard Filter dialog box (Fig. 64). The records with 

Total Sales greater than 4000 will be displayed (Fig. 65). 

 

 



 

 

 

 

 

Fig. 64 Standard Filter dialog box 

 

 

 
 

Fig. 65 Rows after applying Standard Filter 

 

To remove the filter,  

1. Select Data  Filter Remove Filter (Fig. 66). 

 

To hide the filter,  

1. Select Data  Filter  Hide AutoFilter. 

 

To remove the filter from column headings,  

1. Select Data  Filter  AutoFilter. 

 

 



 

 

 
 

 

Fig. 66 Remove Filter option 

 

 

Conditional Formatting 

Conditional formatting is a feature in Clac that allows you to set a cell’s format 

according to the conditions that you specify.  

For example, using conditional formatting, you can display numbers in a particular 

color, depending on whether they are greater than, equal to, or less than a certain 

value. 

 

The steps are: 

 

1. Consider the worksheet given in Fig. 67. 

2. Select cells. In this worksheet C3 to G7. 

3. Select Format  Conditional Formatting (Fig. 68). 

4. The Conditional Formatting dialog box appears (Fig. 69). 

5. To select the formatting for cell value greater than or equal to 60 : 

a. Select New Style button of Condition 1.  

 

 



 

 

 
Fig 67 Worksheet 

 
 

Fig 68 Conditional Formatting option of Format menu 

 

 



 

 

 
 

Fig 69  Conditional Formatting dialog box 

 

 

 

6. The Cell Style dialog box appears (Fig. 70). Select the Font tab and click 

Bold Italic under Typeface.  

 



 

 

 

 

 

Fig 70 Font tab of Cell Style dialog box 

7. Select the Font Effects tab and change the font color (Fig 71).  

8. Select the Background tab and click Black. (Fig 72) 

9.  Click OK. 

 

 

 
 

 

Fig. 71 Font Effects tab of Cell Style dialog box. 



 

 

 
 

Fig 72 background tab of Cell Style dialog box 
 

 

7. Click OK. The Conditional Formatting dialog box appears. Click OK. The 

worksheet will appear as in Figure 73. 

 
 

Fig. 73 Conditional formatting applied 

 

 

Lets Try It 

 

1. Create the following worksheet and perform the following operations: 



 

 

 
a. Sort the table in ascending order of height. 

b. Filter the data to view only those rows where height is more than 8500 m. 

 

2. Create the following worksheet and perform the following operations 

 

 
 

a. Filter the records according to the following condition: 

i. Numbers greater than 60 should in bold, size 14 and green 

color. 

b. Add another column at the end with heading ‘Total marks’ 

c. Calculate total marks for each student. 

d. Now, arrange the data in descending order of Total marks. 

 

 

 



 

 

Self-Management Skills – IV 
11 Sessions (7 Theory and 4 Let’s Do It) 

 

 

 

“Ekalavya, An Ideal For Modern Students, Learnt Archery Without Any External Help. 

By Self-Effort And Faith In One’s Power, Longing For Knowledge And By Self-Reliance, 

One Can Do Miracles..” 

Swami Vivekananda 

 
 

 

Self-motivation 
 

Motivation is defined as the drive required to engage in goal-oriented behavior. Motivation is inner urge 

to do something and self-motivation is ability to do what needs to be done without the influence or 

thrust from other people or situations. Self-motivated individuals are asset to the world, their country, 

their families and to themselves. Self-motivated individuals practice righteousness, means what needs 

to be accomplished, shall be done. Self-motivated people have elevated spirit and full of positivity. For 

them nothing is impossible. They are focused on their goals and objectives and diligently achieve their 

aims.  

Self-motivation is important because 

 It increases individual’s energy and activity. 

 It directs an individual towards specific goals. 

 It results in initiation and persistence of specific activities, thus keeps him/her active. 

 It affects cognitive processes and learning strategies used by individual for completing similar 

tasks. 

 
 

Finding and listing motives 
 

Motivation is classified in different types by different authors such as motivation based on physiological 

and psychological needs. Physiological motivation is based on the physical needs to satisfy hunger or 

thirst. Physiological motivation directs the behavior towards satisfying specific bodily need. 



 

 

Psychological motivations can be guided by need for achievement and need for affiliation. The need for 

achievement is a social form of motivation involving a competitive drive to meet the standards of 

excellence. The need for affiliation involves the need to seek and enjoy close and cooperative 

relationships with others and to adhere and be loyal to a friend. Motivation is also classified as internal 

or external motivation. In case of internal motivation, an individual demonstrates a desire to do his/her 

work without any external reward. External motivation occurs when we feel driven by outside forces, 

performing an activity either to obtain a reward or to avoid punishment. For example, a student who is 

internally motivated will learn, complete assignments on his/her own, whereas a student who is 

externally driven will be completing lessons to avoid punishment or to gain reward. Motivation, basically 

answers “why”, the reason behind doing a task. A person, may be internally or externally motivated as a 

person, in different situations or may be driven by physiological and psychological needs. One should 

identify the motivation in every occasion to handle oneself better.  

 

 

Finding sources of motivation and inspiration 
Following are the sources of motivation and inspiration. 

 Music :  

Music is the language of the soul. A good inspiring piece touches everybody’s heart and can help 

create miracles.  

 Books :  

Books are said to be best friends. They expand our horizon of thinking. They help us visualize the 

unknown and unchartered territories beyond our capacities. Books about heroic acts, inspiring 

lives and stimulating creativity help readers move beyond their routine lives. 

 Activities :  

Engaging in positive and skill enhancing activities keeps our spirits high. Competitions, games, 

simulations, interviews for various committee positions are found to encourage, motivate and 

inspire students.  

 Expansive thoughts:  

Thinking and discussing big and positive ideas motivates us to reach to our highest potential.  

 Living in the present :  

Being present where we are rather than where we are not bring in peace and calmness in our life. 

A calm and peaceful mind can help us achieve wonders. This quality of being aware and conscious 

of one’s self in present moment is also called mindfulness. Mindfulness helps students to pay 

attention, reduce stress and helps promote thoughtful approach towards life. 

 Dreaming big :  

Dreaming big is a journey not a destination. Dreaming big helps us to be mentally prepared to 

take that big leap forward. Only when we aim high, we will be motivated to work hard and 

achieve big things in life. 

  

 



 

 

 

 

Personality types, traits and disorders 

 

Meaning of personality 
Personality is relatively enduring set of traits. These traits are made up of be emotional, behavioral and 

mental set of characteristics. Heredity has been found to be determining personality apart from 

environmental forces. Personality is shaped through family, culture, society, education and other 

environmental factors.  

 

Influence of personality  
Personality affects all aspects of an individual’s performance, even how he/she reacts to situations in 

life. Individuals shall set clear goals for themselves and diligently pursue them. Behavioral tendencies 

like anxiety, stress, perseverance and conscientiousness reflected in personality traits can influence 

academic performance.  

 

Basic personality traits 
According to trait theory, combining a set of observable traits into a group forms an individual’s 

personality. One popular personality classification is big five. The Big Five, are global traits associated 

with work.  

 Extraversion : Gregarious, assertive and sociable.(Opposite reserved, timid, quiet.) 

 Agreeableness : Cooperative, warm and agreeable.(Opposite cold, disagreeable and 

antagonistic) 

 Conscientiousness : Hardworking, organized and dependable(lazy, disorganized and unreliable) 

 Emotional stability : Calm, self-confident and cool(insecure, anxious and depressed) 

 Openness to experience : Creative, curious and cultured(narrow interests) 

 

 

Common personality disorders 
Following are the common personality disorders. If anyone is identified with these disorders, counselling 

shall be provided by family members, teachers and counsellors. 

Paranoid 

Feeling extremely nervous and worried because you believe that other people do not like you or are 

trying to harm you. 

Antisocial 

Is characterized by a pattern of persistent disregard for and violation of the rights of others. 



 

 

Schizoid 

Is characterized by a lack of interest in social relationships and people tend to be distant, detached and 

indifferent. 

Borderline  

Is marked by an ongoing pattern of varying moods, self-image and behavior. These symptoms result in 

impulsive actions and problems in relationships. 

Narcissistic 

Is a condition in which people have an inflated sense of their own importance, a deep need for excessive 

attention and admiration and lack of empathy for others. 

Avoidant 

Avoidant personality disorder is characterized by feelings of extreme social inhibition, inadequacy, and 

sensitivity to negative criticism and rejection. 

Dependent 

Dependent personality disorder is a condition marked by an overreliance on other people to meet one's 

emotional and physical needs. 

Obsessive  

Obsessive-compulsive personality disorder (OCPD) is a personality disorder that's characterized by 

extreme perfectionism, order, and neatness. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

Hands On Exercises to Understand the Concept Better 

          4 Sessions 

 

Session A. Group Discussion on identifying needs and desire 

Session B. Discussion on sources of motivation and inspiration 

Session C. Demonstrate the knowledge of different personality types  

Session D. Essay on reflection on the self-personality type 

 

 

 

 



 

 

  Role of Green Jobs 

 

Industry experts remain hopeful and excited about green jobs market, since 

industries are adopting large scale, energy efficiency measures. There are jobs in 

solar and wind installations, clean car engineering. Households are switching to 

solar energy, families are purchasing alternative energy cars, and news jobs are 

being added to the market place to meet the increasing demand. 

 

 

Picture of coal miners  

There is promising statistics in the green jobs industry. Clean energy has 

experienced incredible growth and success in the past decade and is poised to 

continue to grow in the coming decade; this will collaborate with business to 

advance policies that will do well to environment and economy. These 

technologies are not so costly also, thereby they are adapted widely. 



 

 

Role of Green jobs in toxin free homes: 

In our daily lives we do household work, that releases harmful gases into the 

atmosphere and contribute to the warming of our planet. Green jobs will 

promote the usage of ecofriendly raw materials and conserve energy. 

The following is the list of steps; green jobs can take to reduce greenhouse gas 

emissions; 

 

 Reuse, Reduce, Recycle 

 Use less heat and reconditioning 

 Replace your light bulbs 

 Drive less drive smart 

 Buy energy efficient products 

 Use less hot water 

 Use the off buttons 

 Plant a tree. 

 

 

Green jobs in Solar and wind power:  

The green jobs are as follows;  

 

Energy Auditors- they conduct audits determine how energy efficient the 

building/home are.  

Chief Sustainability officers: they oversee green activities in their organization. 

Wind/ Solar energy engineers: they design and develop wind farm systems 

 



 

 

Role of green jobs in Water Conservation: 

To protect existing and future water supplies, by ensuring that resources are not 

mismanaged, over exploited or otherwise used in manner that would be 

considered damaging. 

 The other jobs in water conservation are;  

Water treatment specialist. 

Water Auditor 

Water policy Analyst 

Water resource planning manager 

Water Quality Monitoring 

Water conservation Representative. 

The above mentioned opening are anywhere, where there is a natural water 

supply for all users and future generations, identify potential problems to the 

ecology or environmental health and mitigate them. 

 

Green jobs in waste Reduction Recycling and Reuse: 

Eco cycle- zero waste creates jobs, recycling, composting and reusing create a lot 

green jobs. Recycling and reuse create at least 9 times more jobs than landfills 

and incinerators. E.g. we need force for collecting, processing and preparing 

materials. 

Its common knowledge that recycling materials helps the environment by 

reducing waste….. depending on materials manufacturers can save up to 60% of 

their production costs by using recycled materials rather than obtaining, refining 

and extracting brand new substances ,e.g. paper, aluminum, plastics. 

 



 

 

Green jobs in Tourism: 

Indonesia is an example of green tourism. Green tourism is also referred as ‘New 

experience economy’, green tourism offers new tourism paradigm; we pay to do 

things, not to have new things. Tourists are buying experience not product. It 

promotes tourists to be prosumers, i.e.to care about the future. Green tourism 

makes an optimal use of environmental resources. The following are the 

principles of green tourism; Respect socio cultural authenticity of host country. 

Provide adequate wages and safe working conditions. Green jobs are required to 

plan; 

 Destination management 

 Destination managers. 

 Trainers. 

 

Green Jobs in building and construction:  

 Green buildings use ecofriendly materials, benefit environment by conserving 

energy. There are plenty of jobs in the construction sector, this sector employs 

millions of people, but suffers from a skill shortfall. Attracting talent and 

investment is a key challenge. Green building offers a chance to be part of the 

solution to global challenges.  

The list of green jobs is as follows; 

 Construction worker, crew member 

 Designer 

 Carpenters 

 Building Planner and coordinators 

 Insulators 

 Weatherization 

 Concrete labors 

 Highway laborers 

 Demolition experts 



 

 

 

Role of green Jobs in limiting Green house emissions 

The key to environmental protection is to prevent the degradation of the natural 

environment, which is important for all living creatures, one of the biggest 

problem in the environment is related to fossil fuels, which leads to pollution , 

climate change and natural resource depletion.  

Green jobs are decent jobs that contribute to preserve or restore the 

environment, be they in traditional sectors, such as in manufacturing and 

construction sectors or in the emerging green sectors such as renewal able 

energy. 

 

 


